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   Microsoft Word Documentآموزش واژه پرداز  -1

 wordروش های باز کردن فایل  1-1

ب  دو روش عمده ایجادبه  توان  می را    wordفایل   فایل متفاوت ه  کرد.  طوریکه در هر روش، نحوه ذخیره کردن 

 باشد.می

 نظر مراحل زیر طی می شود. wordاصلی ویندوز و یا در پوشه  روی صفحه  -1

(Right Click → New → Microsoft Word Document) 

 

 این فایل در همان مکانی که ایجاد شده ذخیره می شود.

 را جستجو کنید.   wordرا از صفحه کلید فشرده( و عبارت   یا کلید  و کرده )استارت کلیک   روی منو -2
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 کان ذخیره سازی فایل را مشخص کنید.کردن این فایل باید م ذخیرهبرای 

 انجام تنظیمات پیش فرض  1-2

I.  راست نویس کردن(Right to Left)  و چپ نویس کردن(Left to Right) صفحه 

را راست نویس کرد. جهت راست    wordجهت تایپ متون فارسی و یا ترکیبی از فارسی و انگلیسی باید صفحه  

 را فعال کنید. ، آیکن  Paragraph، قسمت  Homeنویس کردن صفحه باید در زبانه 

 سمت راست صفحه کلید  Ctrl + Shiftکلید ترکیبی: 

 

،  Homeیس کنید. جهت چپ نویس کردن صفحه باید در زبانه  جهت تایپ متون انگلیسی باید صفحه ورد را چپ نو 

 را فعال کنید.  ، آیکن  Paragraphقسمت 

 سمت چپ صفحه کلید  Ctrl + Shiftکلید ترکیبی: 

 

 

II.  نمایش خط کش(Ruler) 

 .  خط کش را انتخاب می کنیم  Show، در قسمت  رفته Viewخط کش به تب  کردنجهت فعال 

View → Select Ruler 

 

III.  تبدیلInch  بهCm  و یا هر واحد دلخواه دیگر 

می باشد. برای    Inchکه واحد خط کش به طور پیش فرض بر حسب    پس از نماش خط کش، مشاهده می کنید

 . مسیر زیر را در ورد دنبال کنید Cmتبدیل واحد به 
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File → Options → advanced → سربرگ Display → Show measurements in unit of: 

 انتخاب واحد مورد نظر که در اینجا واحد سانتی متر مد نظر است. →

IV.  تغییر سایز برگه 

باید وارد تنظیمات برگه    A4به    Letterمی باشد. جهت تغییر سایز برگه از    Letterسایز برگه به طور پیش فرض  

ترین این  مختلفی وجود دارد. در زیر به رایج   مسیرهای  Page Setup. برای رفتن به قسمت  شوید  Page Setupیا  

 ها اشاره شده است: روش 

 شود.در فایل ورد مسیر زیر دنبال می -1

Page Layout → Page Setup →   کلیک بر آیکن 

 
 روی خط کش  کردن و بار کلیکد -2

 
، در اولین قسمت آبشاری، اندازه صفحه  Paper Sizeشده، در سربرگ    Paper، وارد تب  Page Setupدر قسمت  

 .تغییر دهید A4را به اندازه دلخواه و یا  
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V. افقی و عمودی کردن صفحه 

قسمت   تب  Page Setupدر  وارد   ،Margins  عمودی  شوید حالت  در  فرض  پیش  طور  به  ورد  صفحه   .

ortrait)P(      صفحه، در سربرگ  قرار دارد. جهت افقی کردنOrientation  ،  گزینهcapesLand      را

 فعال کنید. 

VI.  فارسی کردن اعداد 

به طور پیش فرض در نرم افزار ورد تمامی اعداد به صورت انگلیسی نوشته می شود، حتی اگر زبان صفحه کلید روی  

  زبان فارسی تنظیم شده باشد. جهت تغییر دادن تنظیمات به طوری که به هر زبان که نوشته می شود، اعداد نیز به همان 

 زبان تایپ شوند باید مسیر زیر را دنبال کرد. 

File → Options → Advanced →  سربرگ Show document content → Numeral → 

 Context → کلیک بر لیست آبشاری

VII.  یا هم تراز کردن راست چین کردن، چپ چین کردن، وسط چین کردن و 

چین کردن  بروید. جهت راست    Paragraph، به قسمت  Homeجهت چیدن متن در هر کجای خط، باید در تب  

آیکن    (Align Left)، چپ چین کردن  آیکن    (Center)، وسط چین کردن    آیکن    (Align Right)متن  

 مسیر زیر را دنبال کنید. (Justify)هم تراز کردن و یا  
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 صفحات  درج کادر )حاشیه( برای 1-3

 ل شما دارای کادر باشند باید مسیر زیر را دنبال کنید:یاگر بخواهید صفحات فا

 کلیک کنید.   ، روی آیکنPage Background، قسمت Designدر تب 

 کادر زیر را مشاهده می کنید.

 
در اینجا می توانید کادر مورد نظر خود را انتخاب، رنگ آن را تعیین، سایز آن را تغییر دهید و دیگر تنظیمات را بر  

 را کلیک کنید.  Okآن اعمال کنید. در نهایت گزینه 

 کلیدهای ترکیبی  1-4

بازه زمانی کوتاه تر    جهت سریع تر انجام شدن برخی فعالیت ها، می توان با ترکیب دو یا سه کلید، فعالیت ها در

 انجام داد. برخی از کلیدهای ترکیبی عبارتند از:

 Ctrl + R        چین کردن متن  تراس

 Ctrl + L         چپ چین کردن متن 
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 Ctrl + E         وسط چین کردن متن 

 Ctrl + Insert/ و یا  Ctrl + C        کپی کردن

 Shift + Insert/ و یا   Ctrl + V        چسپاندن

 Ctrl + D       کپی کردن و چسباندن پیوسته اشکال

Minimize  کردن تمامی فایل های باز      +D 

 Home      نشانگر ماوس در اول خط مورد نظر قرار گیرد

 End     نشانگر ماوس در انتهای خط مورد نظر قرار گیرد 

 Ctrl + Home     نشانگر ماوس در ابتدای اولین خط صفحه اول قرار گیرد

 Ctrl + End    قرار گیرد  انتهای آخرین خط صفحه آخر نشانگر ماوس در 

 Shift + Alt         تغییر زبان نوشتار 

 Ctrl + S        ذخیره کردن فایل ورد 

 F12       (Save As) ذخیره کردن به عنوان

 Shift + T        ویرگول )در متون فارسی( 

 Shift + K       متون فارسی(باز کردن گیومه )در 

 Shift + L        بستن گیومه )در متون فارسی( 

 Ctrl+Shift+2      ها(تمرین نیم فاصله )جهت کلماتی مانند 

 Enter       رفتن به خط بعد در پاراگراف جدید 

 Shift + Enter       رفتن به خط بعد در پاراگراف فعلی 

 Ctrl + Enter        رفتن به خط بعد در صفحه بعد

 Shift + J   درج خط تیره و یا کشیدن کلمات مانند )کامپیـــوتر( )در متون فارسی( 

 Ctrl + B       کردن( Boldبرجسته کردن متن )

 Ctrl + I         ایتالیک کردن متن 
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 Ctrl + U      کردن(  Underlineزیر خط دار کردن متن )

 Ctrl + N        باز کرن فایل ورد جدید 

 Ctrl + O       باز کردن فایل ورد موجود در سیستم

Switch  کردن بین صفحات باز سیستم      Alt + Tab 

 Alt + F4      بستن فایل ورد )و یا هر فایل باز( به طور کامل 

 Ctrl + W بستن فایل ورد به طوری که فایل خاص شما بسته شود، اما نرم افزار همچنان باز بماند 

1-5 Switch  بزرگ بودن و کوچک بودن حروف )مخصوص عبارات لاتین(  کردن بین حالت های 

  Shift + F3  کلیدهای ترکیبی  برای این منظور روی عبارت مورد کلیک کرده و یا متن مورد نظر را انتخاب کنید.

 دادن این کلیدها، سه حالت مختلف زیر را می توانید مشاهده کنید: ید بفشارید. با هر بار فشار را از صفحه کل

1) COMPUTER IN MANAGEMENT 

2) Computer In Management 

3) computer in management 

1-6  Paste Special متن 

کنید که در قالب عکس باشد و قابلیت ویرایش نداشته باشد.    Pasteگاهی اوقات نیاز دارید متن خود را به گونه ای  

جهت انجام این کار، پس از اینکه فایل خود را انتخاب کردید، مکان نما را در جایی که قرار است متن خود را در قالب  

در   کلیک کنید.  Clipboard، در قسمت  Pasteبروید. روی آیکن    Homeکنید قرار داده، به تب    Pasteعکس  

 را انتخاب کنید.  Paste Specialنوی باز شده گزینه م
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، متن خود را به  Ok، و کلیک بر گزینه  Pictureبا انتخاب گزینه برای شما باز خواهد شد.  Paste Specialکادر 

 عنوان تصویر درج کنید.

 

 انتخاب کردن متن  1-7

i.   ماوس انتخاب متن با 

 کلمه مورد نظر با کلید چپ ماوس، دوبار کلیک کنید.اگر بخواهید یک کلمه را انتخاب کنید، روی 

اگر بخواهید یک پاراگراف را انتخاب کنید، روی یکی از کلمات پاراگراف مورد نظر با کلید چپ ماوس، سه بار  

 کلیک کنید.

ii.  انتخاب متن با صفحه کلید 

همزمان کلیدهای نشانگر    را فشرده و  Shiftاگر بخواهید به صورت حرف به حرف انتخاب را انجام دهید، کلید  

 چپ و راست را انتخاب کنید. 

را همزمان گرفته و کلیدهای   Ctrlو  Shiftاگر بخواهید به صورت کلمه به کلمه انتخاب را انجام دهید، کلیدهای 

 نشانگر چپ و راست را از صفحه کلید فشار دهید.

را فشرده و همزمان کلیدهای نشانگر بالا و    Shiftاگر بخواهید به صورت خط به خط انتخاب را انجام دهید، کلید  

 پایین را انتخاب کنید.

  ، نشانگر ماوس را در ابتدا یا انتهای پاراگراف قرار داده  اگر بخواهید پاراگراف به پاراگراف انتخاب را انجام دهید، 

 همزمان گرفته و کلیدهای نشانگر بالا و پایین را از صفحه کلید فشار دهید.  را   Ctrlو  Shiftکلیدهای 

 را همزمان فشار دهید.   Endو   Shiftجهت انتخاب متن از جایی که نشانگر ماوس قرار دارد تا آخر خط، کلید 
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 شار دهید. را همزمان ف Homeو   Shiftجهت انتخاب متن از جایی که نشانگر ماوس قرار دارد تا اول خط، کلید 

 را فشار دهید.  Ctrl + Aجهت انتخاب تمامی محتوای فایل کلید ترکیبی 

 تغییر سایز متن  1-8

   و   ، به ترتیب روی آیکنFontرفته و در قسمت   Homeجهت کاهش و یا افزایش سایز متن می توانید به تب  

 کلیک کنید و یا از کلیدهای ترکیبی زیر استفاده کنید.

 + Ctrlج    جهت کاهش سایز نوشته به صورت یک سایز یک سایز 

 + Ctrlچ    جهت افزایش سایز نوشته به صورت یک سایز یک سایز 

ه تغییر ی ترکیبی در این است که آیکن ها براساس سایزهای تعریف شدلیدها تفاوت روش استفاده از آیکن و روش ک

 یک سایز.  سایزمی کنند و کلیدهای ترکیبی به صورت یک 

 اگر بخواهید مقداری را بین سایزهای تعریف شده تعیین کنید، باید به صورت دستی این کار را نجام دهید. 

 

 فونت ها  1-9

لاتین را انتخاب کرده که مرسوم ترین   یفونت ها  ،متن حتماً توجه داشته باشید که برای کلمات لاتین هنگام نوشتن

( و یا فونت B Zar)مانند    Bمی باشد، و جهت کلمات فارسی فونت های سری    Times New Romanآن ها فونت  

 را انتخاب کنید.  (Zar 2)مانند  2های سری  

فایلی را که ح تغییر دهیداگر بخواهید فونت  از    ،اوی کلمات لاتین و فارسی است را  باشید که پس  توجه داشته 

 انتخاب آن ها، ابتدا فونت لاتین را اعمال کرده و سپس فونت فارسی را اعمال کنید.

 برگردان به حالت قبل و بعد  1-10
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 دو راه وجود دارد:  (Redo)و حالت بعد  (Undo)جهت برگرداندن عمل انجام شده به حالت قبل 

 آیکن موجود در گوشه سمت چپ و بالای صفحه: استفاده از دو ✓

 Redo، جهت و آیکن   Undo، جهت  آیکن  

 :استفاده از کلیدهای ترکیبی زیر ✓

Undo   Ctrl + Z 

Redo   Ctrl + Y 

 Back Spaceو  Deleteتفاوت کلیدهای    1-11

عبارت های بعدی، و با فشردن    Deleteهرکجا از متن که نشانگر را قرار دهید، مشاهده می کنید که با فشردن کلید  

 عبارت های قبلی پاک می شوند.   Back Spaceکلید 

 درج توان یا اندیس  1-12

 جهت درج توان یا اندیس دو حالت زیر وجود دارد:

 جهت اندیس    جهت توان و آیکن   ، استفاده از آیکن Font، قسمت Homeدر تب  ✓

 استفاده از کلیدهای ترکیبی زیر ✓

 + + Ctrl + Shift   توان 

 = + Ctrl   اندیس 

 تنظیمات مربوط به پاراگراف ها  1-13

 جهت وارد شدن به قسمت تنظیمات مربوط به پاراگراف مسیر زیر را دنبال کنید.

Home → قسمت Paragraph →   کلیک بر آیکن 
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 Indent and Spacingبررسی مشخصات تب اول، 

General → 

Alignment:  )... تنظیمات مربوط به تراز پاراگراف )چپ چین، راست چین، هم تراز و 

Direction:  راست نویس و چپ نویس کردن پاراگراف 

Indentation → 

Before text:  پاراگراف تا حاشیه سمت راست )متن فارسی( یا حاشیه سمت چپ )متن لاتین( تو رفتگی میزان  

After text:  تو رفتگی پاراگراف تا حاشیه سمت راست )متن لاتین( یا حاشیه سمت چپ )متن فارسی(میزان  

Special: → First line:  تعریف شود، تو رفتگی خواهد داشت. خط اول پاراگراف به میزان دلخواهی که  

Special: → Hanging: تعریف شود، تو رفتگی    همه خطوط پاراگراف، به جز خط اول، به میزان دلخواهی که

 خواهند داشت.

By: .میزان دلخواه مربوط به قسمت قبل را در اینجا وارد کنید 

Spacing → 

Before: .فاصله پاراگراف را تا پاراگراف قبل از آن تعیین می کند 

After:  ف را تا پاراگراف پس از آن تعیین می کند.فاصله پاراگرا  

Line spacing:   فاصله خطوط یک پاراگراف با یکدیگر را تعیین می کند. می توان هم از مقادیر تعریف شده

 استفاده کرد و هم مقادیر دلخواه را به طور دستی وارد کرد.
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At:  .مقدار دلخواه مربوط به قسمت قبل را در این جا وارد کنید 

 فظ فونت ها و تغییر پیدا نکردن آن ها هنگام جابه جایی فایل ح 1-14

دستگاهی ایجاد کردید، ممکن است مایل به اشتراک گذاری فایل خود باشید، اما با تغییر هنگامی که فایل ورد را در  

. برای  ی باید فونت ها را حفظ کردجهت جلوگیری از این به هم ریختگفونت هنگام به اشتراک گذاری مواجه شوید،  

 زیر چگونگی انجام این کار را نشان می دهد:انجام این کار دو مسیر وجود دارد. مسیرهای  

✓ File → Options → Save → Preserve fidelity when sharing this document →  

 Embed fonts in the file 

✓ F12 → Tools → Save Options → Preserve fidelity when sharing this 

document →   Embed fonts in the file 

 و ذخیره کردن دستی  ذخیره کردن اتومات به صورت زمانی 1-15

به طور پیش فرض، نرم افزار ورد هر ده دقیقه فایل ما را ذخیره می کند، اما جهت فایل های سنگین ممکن است  

ام نشود و یا جهت کارهای حساس و حیاتی ممکن است بخواهید فاصله زمانی بین این بخواهید که ذخیره اتومات انج 

 ذخیره کردن اتومات کوتاه تر باشد. جهت انجام این تنظیمات مسیر زیر را دنبال کنید:

 جهت فایل های سنگین:

 
 

✓ File → Options → Save → Save document →  Save AutoRecover information 

every  minutes 

 جهت فایل های حساس و حیاتی:

✓ File → Options → Save → Save document →  Save AutoRecover information 

every  minutes 

، در قسمت    را بفشرید و یا روی آیکن   Ctrl + Sاگر مایل باشید این کار را به طور دستی انجام دهید، کلیدهای  

 .لیک کنیدگوشه بالا و سمت چپ نرم افزار ک

 عکس گرفتن از صفحه 1-16
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 هنگام عکس گرفتن از صفحه 

رید و در فایل  ارا از صفحه کلید بفش  PrntScrاگر مایل باشید از کل صفحه مانیتورتان عکس بگیرید باید کلید   ✓

 . (Ctrl + V)مورد نظر خود بچسبانید 

بگیرید،   ✓ خاص عکس  کادری  از  باشید  مایل  طور  اگر  به  و سپس  کرده  کلیک  کادر  آن  روی  همزمان  ابتدا 

 رید.ارا بفش  Alt + PrntScrکلیدهای  

 Styleتعریف  1-17

 Styleچگونگی تعریف 

 :مسیر زیر را دنبال کنید Styleجهت تعریف 

Home → styles →   کلیک بر آیکن 

 

کادر زیر را مشاهده    جدید کلیک کنید.  Style، جهت تعریف  (New Style)  کن  در منوی باز شده، روی آی

 می کنید.
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 ، عنوانی را جهت استایل یادداشت کنید. Nameدر کادر باز شده، قسمت  

قسمت   برای کلمات لاتین  Formattingدر  را  و سایزی  فونت   ،(Latin)    برای را  و سایزی  فونت  و همینطور 

 کنید.تعریف  (Complex)کلمات فارسی 

 
  14، سایز  B Titr، فونت  Complexو برای    14، سایز  Times New Roman، فونت  Latinمثلً برای قسمت  

 را انتخاب کنید.
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گزینه   روی  ها  استایل  پاراگراف  به  مربوط  تنظیمات  شده    جهت  باز  منوی  در  کنید.  کلیک 

Paragraph…  .را انتخاب کنید 

 
 عمل کنید.  13جهت اعمال تنظیمات پاراگراف ها، شبیه مورد 

 ل ها، ابتدا استایل مورد نظر را انتخاب کرده، سپس متن را تایپ کنید.هنگام استفاده از استای

 جهت دو مورد عمده استفاده می شود:  Styleتعریف 

کرده اید. مثل برای تیتر  در صورتی که متنی را با تنظیمات اعلم شده قبلی آماده جهت ویرایش متون: ✓

را تعریف کنید. اما در نهایت عدد را تغییر داده و از شما خواسته    style،  14از شما خواسته شده که با سایز  

تعریف نکرده باشید باید هر کدام از تیترهای   styleاین کار را انجام دهید. در صورتی که    15شده با سایز 

 اب کنید و سپس آن ها را ویرایش کنید، که کاری زمان بر است.فایل خود را به طور جداگانه انتخ 

 تعریف کرده باشید به صورت زیر عمل کنید. Styleاما در صورتی که 

مورد نظر که تمایل به تغییر آن دارید راست کلیک    Styleبروید. روی    Styles، قسمت  Homeبه تب  

را انتخاب کنید. کادری که   Modifyه گزینه  تیتر(، سپس در منوی باز شد  Styleکنید )در این جا روی  

را    Okتعریف کرده اید باز خواهد شد، تغییرات دلخواه را در آن اعمال کرده و گزینه   Styleقبلً در آن  

های شما با توجه به تغییر اعمال شده ی جدید، تغییر خواهند    Styleکلیک کنید. در این صورت تمامی  

 کرد. 

 در ادامه آموزش داده خواهد شد.: جهت درج فهرست ✓
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 Tabاستفاده از  1-18

اگر بخواهید بین دو قسمت از متن نوشته شده در یک سطر خود، فاصله ایجاد کنید، به جای اینکه به مقدار   ✓

موجود در صفحه کلید استفاده   Tabرید می توانید از کلید  ارا بفش  Spaceفاصله ی مورد نیاز خود کلید  

 ، ایجاد فاصله است. Tabکنید. به طور کلی کاربرد کلید 

 موجود در محیط نرم افزار    Tabاستفاده از آیکن 

ات افراد  اگر تعدادی نام دارید و می خواهید برای هر فرد نمره ای را اختصاص دهید، و همینطور می خواهید نمرمثلً  

، ایجاد فاصله بین Tabاستفاده کنید. به طور کلی کاربرد   Tabبا اسامی آن ها از فاصله خاصی پیروی کند باید از گزینه 

 دو متن در یک خط می باشد. 

 برای این مورد شما ابتدا نام افراد را به همراه نمراتشان در کنار هم لیست کنید.

 
سمت چپ نرم افزار توجه کنید. اگر متنتان فارسی است این آیکن باید    بالای خط کشِ    Tabسپس به آیکن  

)تب چپ چین( باشد. اگر در حالتی دیگر بود، روی آیکن تا جایی کلیک کنید که این حالت را   Left Tabدر حالت 

 به خود بگیرد.

 را در حالت راست چین قرار دهید.  Tabاما اگر متنتان انگلیسی است 

 
سپس نشان گر ماوس را دقیقاً جایی قرار دهید که می خواهید فاصله، از آن جا ایجاد شود و عبارت های بعد از آن  

 به سمت چپ صفحه منتقل شوند.
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آن  ، روی خط کش بالای صفحه جایی را کلیک کنید که می خواهید عبارت های بعد از نشان گر ماوس به  سپس

 جا منتقل شوند. 

 
 را از صفحه کلید بزنید.  Tabسپس کلید 

 
 حال اگر می خواهید این فاصله با نقطه چین هایی پر شود، به روش زیر عمل کنید. 

Home → Paragraph →  در تب باز شده روی   → کلیک بر آیکنTab کلیک کنید   

 
 کلیک کنید. …Tabsگزینه   رویدر کادر باز شده،  
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 را بزنید.  Okباز شده، گزینه دوم را انتخاب کرده، سپس  در کادر 

              
 مشاهده می کنید که فاصله بین نام و نمره فرد با نقطه چین پر می شود.

 

 )اشکال(  shapeدرج  1-19
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 باید مسیر زیر را دنبال کنید: Shapeجهت درج 

Insert → Illustrations → shapes 

 
های موجود، شکل مورد نظر خود را انتخاب کرده، جهت قرار دادن آن در صفحه، ماوس را در    Shapeاز بین  

 جای دلخواه قرار داده و همزمان با نگه داشتن کلید چپ ماوس شکل را رسم کنید و آن را به اندازه دلخواه درآورید. 

 ایجاد خواهد شد.  Drawing Toolsبا سربرگ   Formatهنگامی که شکل را رسم کردید، تب جدیدی به نام 

خود را    shape  کلیک کرده و  Edit Shapeروی آیکن    می توانید   Insert Shapesدر تب جدید، از قسمت  

 تغییر دهید.

 
خود استفاده کنید و هم    Shapeمی توانید هم از استایل های آماده جهت ویرایش    Shape Stylesاز قسمت  

 استایل خاصی را برای آن تعریف کنید.
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 Shapeتغییر چگونگی قرارگیری 

به  را تغییر دهید.   Shape، چگونگی قرار گیری  Wrap Text نمی توانید با کلیک بر آیک  Arrangeدر قسمت 

 مختلف قرار دهید.می باشد، که می توانید آن را در حالت های  In Front of Textطور پیشفرض در حالت 

 قرار دهید. In Line with Textآن را در حالت  "به عنوان بخشی از متن"مثلً جهت قرار گیری 

 
انتخاب گزینه    Shapeبا راست کلیک کردن روی   را در    Add Textو  توانید متن دلخواه خود    Shapeمی 

 را انتخاب کنید.  Edit Textمجدداً راست کلیک کنید و گزینه   Shapeروی    جهت ویرایش متن، بنویسید.

 Shapeتغییر سایز و فونت متن 

رفته، سایز و نوع فونت مورد نظر   Font، قسمت  Homeبا یک بار کلیک روی شکل، آن را انتخاب کنید. به تب 

ر خواهد کرد، و اگر تصمیم دارید  خود برای شکل انتخاب کنید. در اینصورت اگر متنی نوشته اید سایز و فونت آن تغیی

 فونت انتخابی شما نوشته خواهد شد.  سایز و متنی بنویسید با

 Shapeتغییر رنگ 

مورد نظر کلیک کنید. سپس در سربرگ سپس در سربرگ فعال شده ی    Shape، روی  Shapeجهت تغییر رنگ  

Drawing Tools  در قسمت ،Shape Styles    هم می توانید ازStyle  ده استفاده کنید و هم آن را به رنگ های آما

 مورد نظر خود درآورید. 

 

 ها Shapeگروه کردن 
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ها کلیک کنید و با این کار    Shapeروی تک تک    Ctrlها، ابتدا با استفاده از کلید    Shapeجهت گروه کردن  

Shape    در سربرگ فعال شده ی  هایی را که می خواهید با هم گروه شوند را انتخاب کنید. سپسDrawing Tools  ،

 را انتخاب کنید.  (Group)اول   ی باز شده گزینهکلیک کنید و در منو    روی آیکن Arrangeدر قسمت 

 

 
داشتید   قصد  گزینه    Shapeاگر  شوند،  خارج  گروه  حالت  از  اید،  کرده  گروه  یکدیگر  با  که  را  دوم  هایی 

(Ungroup) .را انتخاب کنید 
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 Smart Artدرج  1-20

اربردی ای که در مواقع زیادی به کمک شما می آیند. این شکل ها بنابر کاربردشان متفاوت هستند.  شکل های ک

 برخی از آن ها امکان درج تصویر نیز دارند.

 مورد نظر خود را انتخاب کرده و درج کنید. Smart Artمی توانید از مسیر زیر 

Insert → Illustrations → SmartArt 

 
 کلیک کنید.  Okمورد نظر خود را انتخاب کرده و روی گزینه   Smart Artدر کادر باز شده، 
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 Shapeاضافه کردن 

از درج   بخواهید    SmartArtپس  اضافه کردن    Shapeممکن است  اضافه کنید. جهت  بیشتری  روی    Shapeهای 

SmartArt    مورد نظر کلیک کنید و در سربرگ فعال شده یSmartArt Tools تب    ، درDesign    قسمتCraet 

Graphic   روی گزینهAdd Shape  کلیک کرده و انتخاب کنید که می خواهیدShape .جدید در کجا اضافه شود 

 
 رسم شده را انتخاب کنید و همین مراحل را تکرار کنید.  SmartArtموجود در  Shapeشما می توانید یک 

 درج شده   SmartArtتغییر نوع یک 
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مورد نظر خود را رسم کرده اید و تصمیم داشتید آن را تغییر دهید، نیازی به پاک کردن و رسم    SmartArtاگر  

  ، درSmarArt Toolsکرده و در سربرگ فعال شده ی    کلیک  SmartArtدوباره ی آن ندارید. تنها کافیست روی  

 نتخاب کنید. مورد نظر را خود را با کلیک بر روی آن ا SmartArtنوع  Layoutsقسمت   Designتب 

 
 شما به حالت انتخاب شده جدید تغییر می کند.  SmartArtمشاهده می کنید که 

 SmartArtتغییر رنگ 

 ه دارید. اشما دو ر  SmartArtجهت تغییر رنگ 

 SmartArtرنگ آمیزی کل  ✓

را    مورد نظر خود  Smart Art، ابتدا  های آماده موجود در نرم افزار ورد استفاده کنید  Styleاگر تمایل دارید از  

  SmartArt Styles، قسمت  Design، در تب  SmartArt Toolsدر سربرگ فعال شده ی  . سپس  انتخاب کنید

 کلیک کرده و در منوی باز شده، گزینه مورد نظر خود را انتخاب کنید. Change Colorsروی آیکن 
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 Smart Artهای تشکیل دهنده   Shapeرنگ آمیزی  ✓

مورد نظر خود کلیک کرده و    Shape، روی  SmartArtهای تشکیل دهنده    Shapeجهت رنگ آمیزی دستی  

 SmartArtانتخاب کنید. سپس در سربرگ فعال شده ی    Ctrlهای مورد نظر خود را با نگه داشتن کلید    Shapeیا  

Tools  در تب ،Format  قسمت ،Shape Styles  هم می توانید هم از ،Style    های آماده جهتShape   ها استفاده

 ، کنید

 
 و هم به صورت دستی آن ها را رنگ آمیزی کنید.
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 )نمودار( Chartدرج   1-21

 جهت درج نمودار در ورد به صورت زیر عمل کنید.

Insert → Illustrations → Chart 
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 کلیک کردید، کادر زیر فعال خواهد شد.  Okزمانی که بر گزینه  

 
شما را اکسل وصل می کنید. داده های خود    Microsoft Word Documentهمانطور که مشاهده می کنید، کادر 

اندازه نمودارها با توجه به اندازه های وارد شده توسط را در آن وارد کنید، و کادر را ببندید. مشاهده خواهید کرد که  

 شما تغییر خواهند کرد.

 درج تصویر  1-22

 ا عبارتند از:جهت درج تصویر در فایل ورد راه های مختلفی وجود دارد، از جمله این راه ه

 کنید. Paste در مکان مورد نظر تصویر مورد نظر خود را انتخاب کنید. آن را کپی کرده و ✓

 جهت درج تصویر مسیر زیر را دنبال کنید: ✓

Insert → Illustrations → Pictures 
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کلیک    Insertبه آدرسی که تصویر شما در آن جا قرار دارد رفته و تصویر مورد نظر خود را انتخاب کرده و روی گزینه  

 کنید. 
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 ویرایش تصویر

فعال شده ی   به سربرگ  انتخاب کنید. سپس  را  ابتدا آن  رفته و    Picture Toolsجهت ویرایش تصویر خود، 

 رای مثال برخی تنظیمات مربوط به تصاویر در زیر انجام می شود: ب تنظیمات مورد نظر خود را اعمال کنید.

Crop  )کردن )برش زدن 

، روی  Sizeرفته و در قسمت  Picture Toolsکردن تصویر، ابتدا آن را انتخاب کنید، به سربرگ  Cropجهت 

کلیک کنید. با کلیک بر روی این آیکن، تصویر شما به شکل زیر در می آید. از هر طرفی تمایل به برش   Cropآیکن  

کنید )بکشید و رها    Drag & Dropنشانگر ماوس را روی آن قرار داده و کلیک کرده، سپس    زدن تصویر دارید، 

 کنید(. 
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 ما برش زده شده است.در قسمتی از صفحه کلیک کنید ،مشاهده خواهید کرد که تصویر ش
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 تصویر تغییر چگونگی قرارگیری

بر آیکن    Arrangeدر قسمت   با کلیک  توانید  قرار گیری  Wrap Textمی  تغییر دهید. تصویر  ، چگونگی  را 

)در قالب متن( می باشد، که می توانید آن را در   In Line with Textتصاویر هنگام درج به طور پیشفرض در حالت 

 ف قرار دهید. حالت های مختل

قرار دهید. )چگونگی انجام این مراحل در قسمت تغییر چگونگی    In Front of Text   تصویر خود را در حالتمثلً

 آموزش داده شده است.( Shapeقرارگیری 

 و پاک کردن پشت زمینه تصاویر  و جلوه های هنری  تغییر تنظیمات رنگ، روشنایی و تغییر سایز تصویر

،  Colorرفته و به ترتیب برای هر کدام از تغییرات بالا روی آیکن های    Adjustبه قسمت    این تنظیماتجهت تغییر  

Corrections ،Compress Pictures ،Remove Background   وArtistic Effect .کلیک کنید 

در همین    Reset Pictureدر صورتی که تمایل داشتید تنظیمات تصویر را به حالت اولیه برگردانید، روی آیکن  

 قسمت کلیک کنید.

تغییر داده و تصویری دیگر را جایگزین کنید، روی گزینه   باشید که تصویر خود را  در صورتی که تمایل داشته 

Change Picture  .کلیک کنید 
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 (Insert Caption)اویر درج عنوان جهت تص 

 داشته باشند، مسیر زیر را دنبال کنید.  (Caption)تصاویرتان عنوان درصورتی که تمایل داشته باشید 

 کلیک کنید. Insert Captionروی آیکن   Captionsو در قسمت رفته  Referencesبه تب 

 
 کادر زیر برای شما نمایش داده می شود. 

 
 کردن لیست آبشاری برچسب مورد نظر خود را انتخاب کنید. ، با باز Labelدر قسمت 
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 کلیک کنید. New Labelدر صورتی که تمایل داشته باشید برچسب جدیدی تعریف کنید، روی گزینه 

 
پس از وارد    وارد کنید.  Labelکادری برای شما باز می شود که می توانید برچسب مورد نظر خود را در قسمت  

 کلیک کنید. Okورد نظر خود، روی گزینه کردن عنوان برچسب م

 
 عنوانی را که تمایل دارید به تصویر اختصاص دهید را یادداشت کنید.  Captionدر قسمت 
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با باز کردن لیست آبشاری، تعیین کنید که تمایل دارید عنوان تصویر در کجا قرار داشته    Positionسپس در قسمت  

 باشد، در بالای تصویر و یا در پایین آن.

 
 مشاهده می کنید که عنوان تصویر در جایی که شما تعیین کرده اید قرار خواهد گرفت. 
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، قابلیت شماره گذاری خودکار آن است.  Insert Captionاز مزیت های درج عنوان برای تصاویر با استفاده از  

اگر شما تصویری را پاک کنید و یا تصویری جدید در هر جا از متن خود اضافه کنید به طور خودکار شماره گذاری آن 

 ها تصحیح خواهد شد. 

برای تصاویر    همچنین اگر بخواهید فهرست تصاویر خود را درج کنید به سادگی می توانید از قابلیت فهرست اتومات

 استفاده کنید.

 درج فهرست اتومات برای تصاویر

فهرست شما در آن جا درج    ابتدا نشانگر ماوس را جایی که می خواهید  جهت درج فهرست اتومات برای تصاویر،

 Insert Table of Figure، روی آیکن Captionsرفته و در قسمت    Referencesبه تب   ، سپسشود قرار دهید

 کلیک کنید.

 
را باز کرده و برچسبی    Caption Labelبرای شما باز خواهد شد. لیست آبشاری مقابل    Table of Figuresکادر  

 را که می خواهید فهرست مربوط به آن را درج کنید انتخاب کنید. 

 کنید. کلیک و سایز مربوط به فهرست( فونت )جهت ویرایش نوع  …Modifyسپس روی گزینه 
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 کلیک کنید. …Modifyنیز روی گزینه  Styleر در کاد

 
 ابتدا انتخاب کنید برای عبارات لاتین چه فونت و سایزی استفاده شود. 
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 نظر خود را انتخاب کنید.  موردسپس جهت عبارات فارسی فونت و سایز 

 کلیک کنید. Okدر نهایت روی گزینه 

 
 کردن ببندید. Okکادرهای دیگر را نیز با  
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شما همچنین می توانید تمامی این مراحل را برای جداول خود انجام کنید و فهرست جدول ها را نیز در فایل خود    توجه:

 درج کنید.

 Word Artمتن هنری   1-23

به تب   انتخاب کرده،  را  یادداشت کنید. آن  ابتدا متن خود را  ایجاد متن هنری،  بروید. در قسمت    Insertجهت 

Text   روی آیکنWord Art  کلیک کنید. یکی ازStyle  .ها را انتخاب کنید 

 
 Drawingو تب  )جعبه متن( طاهر می شود    Text Boxو در قالب  مشاهده می کنید که متن شما هنری می شود  

Tools  .فعال خواهد شد 
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نحنا دادن به آن و ...( را برای  در این تب نیز می توانید دیگر تغییرات دلخواه )از جمله سایه زدن، چرخش متن، ا

 هنری تر شدن متن خود انتخاب کنید. 

 

 )جعبه متن(  Text Boxدرج  1-24

استفاده می شود که بخواهید نوشته شما    Text Boxرا ایجاد کنید. زمانی از    Text Boxشما خود نیز می توانید  

 ارج از خطوط، نوشته داشته باشید.در جایی خ

  Text Boxروی آیکن   Textرفته و در قسمت   Insertمسیر زیر را دنبال کنید. به تب    Text Boxبرای ایجاد  

 را انتخاب کنید. Text Boxکلیک کنید. یکی از نمونه های  
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کلیک کرده و   Text Boxسپس متن موجود در آن را پاک کرده و متن مورد نظر خود را یادداشت نمایید. روی کادر  

 و سایز نوشته آن را تغییر دهید. فونت

 
 Drawingو فعال شدن تب    Text Boxبا کلیک کردن روی کادر   های خود،    Text Boxمی توانید جهت  

Tools)مانند قسمت قبل( ،  Word Art .تعریف کنید 

1-25 Header   وFooter 

 Footerو  Headerدرج 

  Headerدر صورتی که تمایل داشته باشید در همه صفحات به طور مثال آرم و یا متن خاصی تکرار شود باید از  

یا   و  استفاده کنید.  Footer)بالای صفحه(  از    )پایین صفحه(  های آماده موجود   Footerو    Headerبهتر است که 

 استفاده نشود.

 دو روش وجود دارد: Footerو  Headerجهت درج 

I. را دنبال کنید.ر زیر  مسی 
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Insert → Header & Footer → Select Header → Edit Header 

 
Insert → Header & Footer → Select Footer → Edit Footer 

 
II. و یا ویرایش   جهت درج  Header  .در قسمت بالای صفحه، با کلید سمت چپ ماوس، دو بار کلیک کنید 

 در قسمت پایین صفحه، با کلید سمت چپ ماوس، دو بار کلیک کنید.   Footer  و یا ویرایش  و جهت درج

،  Header & Footer، در قسمت  Insertهمچنین می توانید در تب    Footerو    Headerجهت ویرایش   ✓

 را انتخاب کنید.  Edit Footerو یا    Edit Headerکلیک کرده و گزینه    Footerو یا    Headerروی آیکن  

 & Headerدر سربرگی به نام    Designفعال می باشد، تب جدیدی به نام    Footerو    Headerهنگامی که  

footer Tools .در بالای صفحه باز می شود 
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 صفحه اول با دیگر صفحات Footerو یا   Headerتفاوت 

فاوت باشد، به روش زیر  صفحات دیگر مت  Footerو    Headerصفحه اول با    Footerو    Headerاگر بخواهید  

 عمل کنید:

 Different، گزینهOptions، در قسمت  Header & Footer Toolsمربوط به سربرگ    Designدر تب  

First Page  .را انتخاب کنید 

 
 متفاوتی داشته باشند، به روش زیر عمل کنید: Footerو  Headerبخواهید صفحات زوج و فرد اگر 

 Different، گزینهOptions، در قسمت  Header & Footer Toolsمربوط به سربرگ    Designدر تب  

Odd & Even Pages   .را انتخاب کنید 

 

 Footerو  Headerخارج شدن از حالت 

 دو روش وجود دارد:  Footerو  Headerجهت خارج شدن از حالت  

I.   در وسط صفحه، جایی خارج از قسمتHeader    وfooter  با کلید سمت چپ ماوس، دو بار کلیک ،

 کنید. 

II.  در قسمتHeader & footer Tools  ، کلیک کنید.  ،  روی آیکن 
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ا باید  هم متن داشته باشید و هم شماره صفحه، توجه داشته باشید که ابتد  Footerو یا    Headerاگر بخواهید در   ✓

 شماره صفحه را درج کنید سپس متن خود را اضافه کنید.

 Footerداشت و هم  Headerدر یک فایل ورد و در یک صفحه هم می توان   ✓

 شما زیر خط دار شود، دو روش زیر را می توانید دنبال کنید: Headerاگر بخواهید قسمت  ✓

 Shapeاستفاده از  (1

  Enterکلید فشار داده و سپس  صفحه  کلید خط تیره را از  بعد از اینکه متن خود را نوشتید، سه بار   (2

 را بزنید. 

 (Page Number)درج شماره صفحه   1-26

کلیک    Page Number، روی گزینه  Header & Footer، قسمت Insertجهت درج شماره صفحه، در تب  

کنید. بر اساس اینکه می خواهید شماره صفحه در کدام قسمت از صفحه قرار داشته باشد، روی هر کدام از گزینه ها  

 کلیک کنید و نوع شماره صفحه مورد نظر خود را انتخاب کنید. 
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سمت راست   Ctrl + Shiftجهت فارسی کردن اعداد شماره صفحه می توانید عدد را انتخاب کرده و کلیدهای ترکیبی  

 رید. ارا بفش

 باشید.   Footerو یا    Headerکه ابتدا شماره صفحه را درج کنید، سپس اقدام به اضافه نمودن متنی برای    بهتر است

 شماره صفحه به روش زیر عمل کنید:اما اگر ابتدا متن را وارد کردید، جهت اضافه نمودن 

، روی  Header & Footer، در قسمت  Header & Footer Toolsمربوط به سربرگ    Designدر تب  

را انتخاب کنید و از آن جا نوع   Current Positionکلیک کنید و از منوی باز شده، گزینه  Page Numberآیکن 

شما تغییری   Footerو یا    Headerشماره ای که مد نظرتان است را انتخاب کنید. با این کار، بدون این که متن مربوط به  

 کند، شماره صفحه درج خواهد شد.

 

 (Section)ایجاد فصل  1-27

  Headerمعمولاً برای کتاب ها و پایان نامه ها نیاز است که فصل های متعددی داشته باشیم به گونه ای که در قسمت  

 هر فصل، عنوان فصل مربوطه نوشته شود. برای اینگونه موارد باید فصل ایجاد کنیم.

 ایجاد فصل جدید  چگونگی

جهت ایجاد فصل جدید، ابتدا نشان گر ماوس را جایی قرار دهید که می خواهید پس از آن، فصل جدید ایجاد شود، 

 مسیر زیر را دنبال کنید:سپس 
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باز شده، در    Breaks، روی آیکن  Page Setup، قسمت  Page Layoutدر تب   کلیک کرده و در منوی 

 را انتخاب کنید.   Next Page، گزینه  Section Breaksسربرگ 

Page Layout → Page Setup → Breaks → Section Breaks → Next Page 

 
فصل پیشین، در فصل    Footerو یا    Headerفصل جدید به طور پیش فرض به فصل پیشین خود لینک است، و  

)افقی و عمودی بودن(، نحوه قرار گیری صفحات  ،  Footerو    Headerد نیز اعمال می شود. اگر بخواهید تنظیمات  جدی

گر تنظیمات مربوط به صفحات فصل جدید، با فصل پیشین  و دی  کادر صفحاتسایز صفحات،  نوع شماره بندی صفحات،  

 جام این کار، مسیر زیر را دنبال کنید:را غیر فعال کنید. جهت انبه فصل قبلی  باشد، باید لینک  متفاوت

فصل جدید دو بار کلیک کنید، در  Headerفصل جدید با فصل پیشین، در قسمت   Headerبرای متفاوت بودن  ✓

، مشاهده می کنید که  Navigation، در قسمت  Header & Footer Toolsمربوط به سربرگ    Designتب  

مربوط به فصل جدید گزینه ای به نام    Headerدر قسمت  فعال است و همینطور    Link to Previousآیکن  

Same as Previous .وجود دارد 

فعال ، آن را غیر برای اینکه فصل جدید، نسب به فصل جدید متفاوت باشد، با کلیک روی آیکن  

 نیز دیگر وجود نخواهد داشت.  Same as Previousکنید. با این کار مشاهده می کنید که گزینه 
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فصل جدید کلیک    Footerفصل پیشین متفاوت باشد، در قسمت    Footerفصل جدید نیز با    Footerاگر بخواهید   ✓

 کنید و همین مراحل را دنبال کنید. 

( قرار داشته  Landscape)یا صفحات فصل جدید در حالت افقی    سایز فصل جدید متفاوت باشداگر بخواهید   ✓

ایز مورد نظر خود  فصل جدید قرار داد، به قسمت تغییر سایز صفحه رفته و س، هنگامی که نشان گر ماوس در  باشند

 ( را انتخاب کنید. Landscape)یا حالت افقی  

را انتخاب کنید تا تنظیمات   This Sectionگزینه  ،  :Apply toدر قسمت  ،  Okاما قبل از کلیک کردن بر گزینه  

 مربوط به سایز جدید، فقط در این فصل اعمال شود. 

)تمام سند یا    Whole document)از این نقطه به بعد( و    This point forwardنه های دیگر عبارتند از:  گزی

 که بسته به نیازتان، گزینه انتخابی متفاوت خواهد بود.  فایل(
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 کلیک کنید.  Okسپس روی گزینه 

ر فصل جدید قرار داشته باشد، سپس به قسمت  اگر بخواهید کادر فصل جدید متفاوت باشد، باید نشانگر ماوس د ✓

 و کادر مورد نظر خود را انتخاب کنید. انتخاب کادر بروید،

را انتخاب کنید تا تنظیمات   This Section، گزینه  :Apply to، در قسمت  Okاما قبل از کلیک کردن بر گزینه  

 مربوط به کادر، فقط در این فصل اعمال شود. 

 
 کلیک کنید.  Okسپس روی گزینه 

 تایپ سریع کلمات پر کاربرد 1-28
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جهت افزایش سرعت در تایپ متن و جلوگیری از اختصاص دادن زمان به تایپ کلمات پر کاربرد، حروف اختصاری  

به طور  به کلمات پر کاربرد اختصاص داده می شود. با نوشتن این حروف اختصاری، مشاهده می کنیدکه نرم افزار ورد، 

 اتومات کلمه مورد نظر شما را به طور کامل تایپ می کند.

در متن شما زیاد کاربرد داشته باشد، جهت اینکه نخواهید این   "مجتمع آموزش عالی گناباد"مثلً هنگامی که کلمه 

اول کلمه  )حرف    "م"ورد تعریف می کنید؛ هنگامی که حروف  نرم افزار  عبارت طولانی را هر بار تایپ کنید، برای  

مجتمع آموزش  "نوشتید، به طور اتومات برای شما عبارت    "مع"را به صورت  (  "عالی")حرف اول کلمه    "ع"( و  "مجتمع"

 درج شود.  "عالی گناباد

 برای تعریف کردن این مراحل، باید مسیر زیر را دنبال کنید:

File → Options → Proofing → AutoCorrect options →   کلیک بر آیکن 

 
، عبارتی که توسط خودتان  Replaceقسمت  ،  Replace text as you type  سربرگ در کادر باز شده، در  

، عبارتی که می خواهید Withرا وارد کنید( و در قسمت    "مع"نوشته خواهد شد را وارد کنید )در این مثال عبارت  

 را وارد کنید. "مجتمع آموزش عالی گناباد"توسط نرم افزار برای شما درج شود را وارد کنید )در این مثال عبارت  
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 کنید. Okرا نیز  Word Optionsکلیک کنید. کادر  OKکلیک کرده، سپس بر روی گزینه   Addبر روی گزینه  

را از صفحه کلید بفشرید و مشاهده خواهید کرد که کلمه    Spaceکلید    "مع"هنگام تایپ، پس از نوشتن کلمه  

 درج خواهد شد.( "مجتمع آموزش عالی گناباد"ین جا عبارت مورد نظر شما )در ا

جایگزین    "مجتمع آموزش عالی گناباد"را بنویسید، اما نخواستید با عبارت    "مع"اگر زمانی خواستید خود کلمه  

استفاده از آیکن موجود و یا با استفاده از کلید ترکیبی  یا با  کنید.    Undoنیازی به پاک کردن نیست، تنها کافیست    ،شود

Ctrl + Z  .می توانید این کار را انجام دهید 

 ایجاد فهرست اتومات 1-29

، در سربرگ  Layout، در تب  Page Setupبرای درج فهرست برای متون فارسی توجه داشته باشید که در قسمت  

Section قسمت ،Section direction  در حالتRight to Left  .باشد 
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تعریف کرده باشید. به طور پیش فرض در ورد فهرست اتومات    Styleجهت ایجاد فهرست اتومات شما ابتدا باید  

 تعریف شده است. Heading 3و  Heading 1 ،Heading 2برای استایل هایی با عناوین 

 جهت ایجاد فهرست مسیر زیر را دنبال کنید:

شوید،   Referencesوارد تب را دقیاً جایی قرار دهید که می خواهید فهرت در آن جا درج شود. نشان گر ماوس 

 Customکلیک کنید و در منوی باز گزینه    Table of Contentsبر روی آیکن    Table of Contentsدر قسمت  

Table of Contents… .را انتخاب کنید 

 
 کلیک کنید. Optionsروی گزینه  در کادر باز شده  
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  Heading 1  ،Heading 2  مقابل  در  شده  نوشته  اعداد ،Table of Contents Optionsدر کادر مربوط به  

 را پاک کنید. Heading 3و 

باشد. در مقابل استایل    "زیر تیتر دوم "و    "زیر تیتر اول"،  "تیتر"فرض کنید متن شما حاوی استایل هایی با عناوین  

 را بنویسید.  3عدد  "زیر تیتر دوم"و در مقابل استایل   2، عدد "زیر تیتر اول"بل استایل ، در مقا1، عدد "تیتر"

           
 کلیک کنید.  Okسپس روی گزینه 

 کلیک کنید.  Modifyبه کادر اول باز می گردید. این بار روی گزینه 
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را انتخاب کرده و روی    TOC 1  ،("تیتر"را به آن اختصاص داده بودید )یعنی استایل    1برای استایلی که شماره  

 کلیک کنید. Modifyگزینه 

 
را پر   Formattingقسمت  باز خواهد شد. همانگونه که هنگام تعریف استایل    Modify Styleکادری با عنوان  

 موجود در فهرست خود تعریف کنید. "تیتر"می کنید، در اینجا نیز فرمتی را برای استایل 

     
 کنید. Okروی گزینه موجود 
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را انتخاب    TOC 2(،  "زیر تیتر اول "را به آن اختصاص داده بودید )یعنی استایل    2سپس برای استایلی که شماره  

 مجدداً فرمتی را جهت زیر تیتر اول در فهریت تعریف کنید. کلیک کنید. و Modifyکرده و روی گزینه 

فهرست برای شما  کنید.    Okتمامی کادرها را    انجام دهید.  "زیر تیتر دوم"، مربوط به  TOC 3همین کار را برای  

 درج خواهد شد. 

چگونگی  د.  هرست را دوباره بروز رسانی کنیهر هنگام که تغییری در صفحات و متن شما ایجاد شد، در نهایت ف 

 بروز رسانی فهرست در ادامه شرح داده شده است: 

 را انتخاب کنید.  Update Fieldابتدا روی قسمتی از فهرست راست کلیک کرده، سپس گزینه 

 
 کادر زیر برای شما نمایش داده می شود: 

 
با توجه به نیاز خود، که آیا می خواهید تنها شماره صفحات را بروزرسانی کنید و یا خود عناوین نیز تغییری در آن ها  

اعمال شده و خواهان بروزرسانی همزمان عناوین و شماره صفحات هستید، به ترتیب یکی از دو گزینه موجود را انتخاب  

 را کلیک کنید.   Okکنید و گزینه 

 در ورد (Equation)رمول نوشتن ف  1-30
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 قرار داشته باشید. Left to Rightبرای فرمول نویسی در نرم افزار ورد توجه داشته باشید که بهتر است در حالت 

 جهت نوشتن فرمول، مسیر زیر را دنبال کنید.

با توجه به ساختار فرمول مورد    کلیک کنید.  Equationرفته و روی آیکن    Symbols، به قست  Insertدر تب  

 استفاده کنید. Structuresنیازتان، از انواع ساختارهای موجود در قسمت 

 

 

 (Symbols)درج نمادها  1-31

 نمادهای مختلف در ورد، از این قابلیت موجود در نرم افزار ورد استفاده کنید.جهت درج 

 دنبال کنید:جهت استفاده از نمادهای موجود، مسیر زیر را 

کلیک کنید. در منوی باز شده، روی گزینه    Symbolرفته و روی آیکن    Symbols، به قست  Insertدر تب  

more Symbols  .کلیک کنید 

  Insertانتخاب کنید و پس از انتخاب نماد مورد نیاز خود، روی گزینه    Fontابتدا فونت مد نظر خود را قسمت  

 را ببندید.  Symbolکلیک کنید و در نهایت پنجره 

 نمادها و علئم معمول را دارند.  Wingdings 3و  Wingdings ،Wingdings 2معمولاً فونت های 
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 درج جدول  1-32

 جهت درج جدول مسیر زیر را دنبال کنید. 

Insert → Table → Insert Table… 
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، تعداد ستون ها و در قسمت  Number of Columns، در قسمت  Table Sizeدر کادر باز شده در سربرگ  

Number of rows  تعداد سطرهای مد نظر خود را یادداشت کنید و گزینهOk  .را کلیک کنید 

 
 جهت چگونه چیدن )چپ چین، راست چین، وسط چین و...( متن در جدول، مسیر زیر را دنبال کنید. 

سربرگ   کنید،  کلیک  جدول  روی  ش  Table Toolsابتدا  خواهد  تب  فعال  در  قسمت  Layoutد.  در   ،

Alignment  .می توانید تنظیمات مربوط به چگونه چیدن متنتان را انجام دهید 

 
قرار دهید. جهت انجام این کار، همانگونه که قبلً آموزش داده    Singleبرای جدول، فاصله بین خطوط را در حالت  

 شد، مسیر زیر را دنبال کنید:

Home → Paragraph → آیکنکلیک بر    → Spacing → Line Spacing 

 اضافه نمودن سطر و یا ستون

روش و در ویرایش های قبلی یک روش برای انجام این کار وجود    2به بعد  Microsoft Office 2013در ویرایش 

 دارد:
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ستون  جهت اضافه نمودن سطر و یا ستون می توان به ترتیب نشان گر ماوس را روی خطوط بین دو سطر و یا دو   -1

 به بعد(  Microsoft Office 2013)در ویرایش  قرار داد و با نمایش علمت روی آن کلیک نمود.
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یا ستون  -2 و  اطراف آن سطر  را در سلولی که می خواهیم  . در سربرگ  دهیداضافه کنیم قرار    نشان گر ماوس 

Table Tools در تب ،Layout در قسمت ،Rows & Columns ،  یکی از گزینه های قرار دادن در بالا

و قرار دادن در پایین )جهت اضافه نمودن سطر(، قرار دادن در چپ و قرار دادن در راست )جهت اضافه نمودن  

 (Microsoft Officeستون( را استفاده کنید. )در تمامی ویرایش های  

 

ر نیز وجود دارد. نشانگر ماوس  راهی دیگر جهت اضافه نمودن سطر: جهت اضافه کردن سطر یک راه دیگ ✓

 را از صفحه کلید بفشرید.  Tabرا در آخرین سلول آخرین سطر خود قرار داده و کلید 

 در جدول  Tabتفاوت کاربرد کلید 

ایجاد فاصله می باشد. اما در جدول هنگامی که    Tabهمانگونه که قبلً آموزش داده شد، کاربرد کلید   ✓

هید شد که به سلول بعدی منتقل می شود. جهت ایجاد فاصله در جدول  را بفشرید، متوجه خوا  Tabکلید  

 استفاده کنید. Ctrl + Tabباید از کلیدهای ترکیبی 

 درج خط مورب در سلول 

جهت انجام این کار، مسیر زیر را دنبال    در مواردی ممکن است نیاز باشد در سلول خاصی خط مورب درج کنید.

 کنید: 
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منوی  کلیک کنید. در    Borders، روی آیکن  Bordersقسمت    ،Designتب    ، درTable Toolsدر سربرگ  

 را بسته به نیاز خود انتخاب کنید.  و      باز شده یکی از گزینه های

 

 ها  Borderبرای   Styleتغییر 

 . خاصی را به آن اختصاص دهید انتخاب کنید Borderابتدا محدوده ای که می خواهید 

 ها مشکی است. جهت تغییر رنگ مسیر زیر را دنبال کنید.  Borderرنگ پیش فرض 

در تب  Table Toolsدر سربرگ    ،Design  قسمت  ،Borders  ،  آبشاری لیست  بر    Pen Colorبا کلیک 

 را تغییر دهید. Borderمی توانید رنگ  

 
خود، مشاهده می کنید که آیکن ماوس شما به شکل قلم مو در می آید. هم می توانید    پس از انتخاب رنگ مد نظر

کنید تا به رنگ مد نظر شما درآید و هم می توانید    کلیکهای مد نظر خود در جدول برده و    Borderقلم مو را روی  

 کلیک کرده و انتخاب کنید که رنگ انتخاب شده روی چه محدوده ای اعمال شود.  Bordersروی آیکن 

 را با کلیک کردن غیر فعال کنید.  Border Painterبرای غیر فعال کردن ویژگی رنگ آمیزی آیکن 



 

68 

 

ها می توانید در همین قسمت روی    Borderمی باشد. جهت تغییر سایز    Point  2/1ها   Borderسایز پیش فرض  

نیز در همین قسمت با کلیک    Borderکلیک کرده و در منوی باز شده، سایز مد نظر خود را انتخاب کنید. نوع  آیکن  

 بر آیکن قابل تغییر می باشد.

 استفاده کنید.  در مسیر زیر های آماده Style، همینطور شما می توانید از ها  Borderبرای  Styleتغییر  جهت

ها را    Styleکلیک کنید. در منوی باز شده، بسته به اختیار خود یکی از    Border stylesروی آیکن مربوط به  

 انتخاب کنید. 

 را انتخاب کنید. مد نظر خودکلیک کرده و گزینه   Bordersسپس روی آیکن 

 سلول ها  (Split)و دو بخشی کردن  (Merge)ادغام کردن 

 سلول ها (Merge)ادغام کردن 

در   بروید. Table Toolsدر سربرگ   Layoutابتدا باید سلول های مد نظر خود را با ماوس انتخاب کنید. به تب  

 کلیک کنید. Merge Cells، روی آیکن  Mergeقسمت 

 

 

 سلول ها  (Split)دو بخشی کردن 
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بروید. در قسمت    Table Toolsدر سربرگ    Layoutسلول و یا سلول های مورد نظر خود را انتخاب کنید. به تب  

Merge روی آیکن ،Split Cells .کلیک کنید 

 
 در کادر باز شده انتخاب کنید که چند ستون و چند سطر ایجاد شود. 

 
 کلیک کنید.  Okسپس روی گزینه 

 

 جدول در صفحات بعدی  Headerتکرار 

. برای مثال که ادامه ی آن به صفحه بعد منتقل می شودگاهی اوقات ممکن است جدول تان به اندازه ای بزرگ باشد  

 جدول زیر را در نظر بگیرید.
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 )سربرگ( جدول تان، در صفحه بعد نیز قابل مشاهده باشد. Headerبهتر است  در اینگونه موارد 

 کار مسیر زیر را دنبال کنید:جهت انجام این 

،    Layout، در تب Table Tools)سربرگ( جدول خود را انتخاب کنید.سپس در سربرگ   Headerابتدا محدوده  

 فعال کنید. مربوطهرا با کلیک کردن روی آیکن   Repeat Header Rows، گزینه Dataقسمت 
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 ر می شود.مشاهده می کنید که سربرگ انتخابی شما در صفحه بعد تکرا

توجه داشته باشید که تنها سربرگ اولیه قابل ویرایش است و سربرگ دوم به هیچ وجه به طور مستقیم قابلیت ویرایش  

 ندارد. 

 چپ نویس و راست نویس کردن جدول 
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قبل از درج جدول توجه داشته باشید که متن شما فارسی است و یا لاتین. در صورت فارسی بودن ابتدا در حالت   1

Right to Left  باشید، و در لاتین در حالتLeft to Right  .و سپس اقدام به درج جدول کنید 

 اما اگر فراموش کردید جهت تغییر حالت جدول باید مسیر زیر را دنبال کنید:

 را انتخاب کنید. نوی باز شده گزینه  نید. در ماز جدول راست کلیک ک ی روی قسمت

 
 Rightبنابر زبان متن خود، جدول را در حالت  Table Direction، قسمت  (Table)در کادر باز شده، در تب اول  

to Left  و یاLeft to Right  .قرار دهید 
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 کلیک کنید. Okسپس بر روی گزینه 

 چگونگی تشخیص راست نویس و یا چپ نویس بودن جدول 

در بالا    لمت  نویس بودن جدول با ماوس روی جدول بروید. اگر عجهت تشخیص راست نویس بودن و یا چپ  

، جدول شما در حالت راست نویس قرار دارد و اگر در بالا و سمت چپ جدول قرار  و سمت راست جدول قرار داشت

 قرار دارد.  چپ نویسداشت، جدول شما در حالت  

 جدول زیر در حالت راست نویس قرار دارد. 

 

 ( کلیک کنید. جدول فقط کافی است روی همین علمت )برای انتخاب کل 
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 رنگ آمیزی جدول 

ممکن است زمانی نیاز داشته باشید که قسمتی از جدول شما )برای مثال سربرگ( دارای رنگ خاصی باشد. جهت  

 استفاده از این قالیت نرم افزار ورد، مسیر زیر را دنبال کنید:

انتخاب ماوس  با  را  نظر خود  مد  در سربرگ    محدوده  تب  Table Toolsکنید.   ،Design  قسمت  ،Table 

Styles روی آیکن مربوط به ،Shading .کلیک کنید 

 
 سپس رنگی را برای رنگ آمیزی محدوده مورد نظر خود انتخاب کنید. 
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 تبدیل جدول به متن 

انتخاب کنید. سربرگ   ابتدا جدول خود راتبدیل کنید،  در صورتی که تمایل داشته باشید جدول خود را به متن  

Table Tools    فعال می شود. به تبLayout    رفته و در قسمتData  ،  روی گزینهConvert to Text   کلیک

 کنید. 

 تبدیل متن به جدول 

ا متن مورد نظر را انتخاب  جهت انجام این کار، ابتددرصورت تمایل می توانید متن خود را نیز به جدول تبدیل کنید.  

 Convert Text to Tableکلیک کنید. در منوی باز شده، گزینه    Tableبروید. روی آیکن   Insertکرده، به تب  

 را انتخاب کنید.

 
جدول خود را  ، تعداد سطر و ستون های  Table Size، در قسمت  Convert Text to Tableدر کادر باز شده  

 تعیین کنید. 
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، تعیین کنید که با توجه به چه آیتمی متون از هم جدا شده و خط های جداکننده  Separate text atدر قسمت  

 سلولهای جدول درج شود.

 اعمال تنظیمات مربوط به یک متن روی متنی دیگر  1-33

باشد و می خواهید   ...( می  و  فونت، رنگ  نظر سایز،  )از  تنظیمات خاصی  متنی دارید که دارای  دقیقاً همان  اگر 

تنظیمات را روی متنی دیگر اعمال کنید، لازم نیست که تک تک موارد را روی متن جدید خود اعمال کنید. تنها کافی  

روی  ماوس خود را  رفته و    Clipboard، قسمت  Homeاست قسمتی از متن قبلی خود را انتخاب کنید، سپس به تب  

 قرار دهید.  آیکن  

 Formatآیکن  ، دو بار روی را روی چندین قسمت از متن خود اعمال کنیدفرمت متن مورد نظر  اگر می خواهید 

Painter    بار اعمال کنید،    خواهید فرمت بکلیک کنید و اگر برای یک  بار روی آیکن  را   Format Painterیک 

 کلیک کنید.

 را انتخاب کنید. روی آن اعمال شودسپس با ماوس متنی را که می خواهید فرمت 

کلیک کرده باشید، پس از یک بار اعمال به طور خودکار    Format Painterدر صورتی که یک بار روی آیکن  

 غیر فعال خواهد شد.

اما در صورتی که دوبار روی آیکن کلیک کرده باشید، جهت غیر فعال سازی می توانید مجدداً یک بار دیگر روی  

 را از صفحه کلید بفشرید.  Escد و یا کلید  کلیک کنی Format Painterآیکن 

 (Endnote) و پانویس (Footnote)درج پاورقی  1-34

برای عبارت مورد نظر خود، نشانگر ماوس را بلفاصله بعد از عبارت مورد نظر    )و یا پانویس(  جهت درج پاورقی

 خود قرار داده و مسیر زیر را دنبال کنید: 

References → Footnotes → Insert Footnote (Insert Endnote) 
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رفته و شما می توانید پاورقی درج کنید. اما    صفحه  نی به پائ  نشانگر ماوس،  Insert Footnote  هنیگز  با انتخاب

شما می توانید توضیح مطلب و    رود  یم  نشانگر ماوس به صفحه آخر فایل شما  Insert Endnoteانتخاب  درصورت  

 جا بنویسید.خود را آن 

را    ک یطور عدد    نیو هم  عبارت مورد نظر شمامتن بعد از    طیبالاتر در مح   ی کم  ،کی بطور خودکار عدد  همچنین  

یا صفحه آخر(  صفحه    نیپائ همینطور )و  و  مح   یبرا  درج می شود  پاورق  طیجدا کردن  و  یک خط جداکننده    ی متن 

(Separator) درج می شود. 

 

 خود را با انتخاب آن تغییر دهید. )و یا پانویس( فونت پاورقیشما می توانید سایز و 

تغییر دهید، هم می توانید به طور دستی به  را    )و یا پانویس(  در صورتی که بخواهید توضیح نوشته شده در پاورقی

  Footnoteای آن  و هم می توانید در متن، روی عبارتی که برپایین صفحه )و یا صفحه آخر( رفته و این کار را انجام دهید  
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دو بار کلیک کنید تا به طور خودکار به قسمتی که توضیحات را در آن نوشته اید   ،( اختصاص داده ایدEndnote)و یا 

 )پاورقی و یا پانویس( انتقال داده شوید. 

  انتخاب کلمه درون متن را    یشماره بالا  ،بین برده و پاک کنیدرا از  )و یا پانویس(    یپاورق   دیبخواه  که  یدر صورت 

 . دیربفش دیرا از صفحه  کل Delete  دیکرده و کل

 ( Endnote Separator)و یا  Footnote Separator  چپ چین، راست چین و وسط چین کردن خط

فارسی است، پس از راست نویس کردن متن خود، مشاهده می کنید که  ر توضیح شما در پاورقی )و یا پانویس(  اگ

 جابجا نخواهد شد.  Separatorخط 

 
  باشد، ممکن   د و اگر لاتین است در سمت چپمسلماً تمایل دارید که خط جدا کننده در سمت راست قرار داشته باش

 است گاهی هم نیاز داشته باشید که آن را در حالت وسط چین قرار دهید. 

کلیک کنید. در  رفته و   Outlineروی گزینه  Viewsرفته، و در قسمت   Viewجهت انجام این کار ابتدا به تب  

 برای شما فعال خواهد شد.   Outliningاین صورت تب  
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 کلیک کنید. Show Notesبرگشته و روی آیکن  Referencesمجدداً به تب 
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توجه: اگر در فایل خود هم پاورقی و هم پانویس داشتید، کادری برای شما به نمایش در خواهد آمد. در این کادر  

از شما پرسیده می شود که آیا تمایل دارید محدوده پاورقی برای شما به نمایش در آید و یا محدوده پانویس. با توجه به  

 کلیک کنید. Ok  نیاز خود گزینه مورد نظر را انتخاب کرده و روی

 
 در می آید.  در پایین صفحه کادری برای شما به نمایش
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)و یا    Footnote Separatorرا باز کرده و گزینه  (  Endnotes)و یا    Footnotesلیست آبشاری مقابل عبارت  

Endnote Separator ) .را انتخاب کنید 

 
برای  (  Endnote Separator)و یا    Footnote Separatorمشاهده می کنید که در کادر پایین صفحه، خط  

 شما نمایش داده می شود.

 
روی آیکن مورد نظر خود )چپ چین، وسط چین و یا   Paragraphبرگشته و در قسمت    Homeسپس به تب  

ه قبلً در قسمت کلیدهای ترکیبی آموزش داده شد؛ همانطور ک،  Homeراست چین( کلیک کنید. )به جای رفتن به تب  

 +Shiftجهت وسط چین کردن و یا  Shift+ Eجهت راست چین کردن،  Shift+ Rمی توانید از کلیدهای ترکیبی 

L  جهت چپ چین کردن خطFootnote Separator   و یا(Endnote Separator ) ).استفاده کنید 
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کلیک    Close Outline Viewبرگشته و روی آیکن    Outlining  به تب  Outlineجهت خارج شدن از حالت  

 رفته و کلیک کنید.  Print Layoutروی گزینه   Viewsرفته و در قسمت   Viewکنید و یا به تب  

 
 به سمت راست منتقل شده است. Separatorمشاهده می کنید که خط 

 

 ( Endnote Separator)و یا  Footnote Separatorتغییر اندازه خط  

و در لیست    داده شده در قسمت قبل را طی کردید  هنگامی که مراحل آموزش  Separatorجهت تغییر اندازه خط  

گزینه   یا    Footnote Separator آبشاری  کردیدEndnote Separator)و  انتخاب  را  کافیست(  تنها  خط   ، 

Separator ش داده می شود را پاک کنید. که در کادر پایین نمای 
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صور   به  دستیو  ترکیبی    از  ت  و  Shift+ Jکلیدهای  کنید  خط    استفاده  که  میزانی  اندازه    Separatorبه  به 

 تکرار کنید. ، این کلیدها را رسددلخواهتان ب

 
 خارج شوید. Outlineهمانطور که در قسمت قبل آموزش داده شد، از حالت  

 تغییر می کند. Separatorمشاهده می کنید که اندازه خط 

 

 و برعکس Endnoteبه   Footnoteتغییر حالت 

های خود    Endnoteو یا تمامی    Endnoteهای خود را به    Footnoteداشته باشید تمامی    ممکن است گاهی نیاز

نیازی نیست که همه آن ها را پاک کنید و مجدداً آن ها را اعمال کنید.   تبدیل کنید. در این صورت   Footnoteرا به  

 کلیک کنید.  روی آیکن   Footnotesرفته و در قسمت  Referencesتنها کافیست به تب 

 
 کلیک کنید. Convertدر این کادر روی گزینه رای شما به نمایش در می آید. بکادری 
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زیر را مشاهده می کنید. در این کادر شما سه گزینه دارید که باید یکی    ، کادرConvertروی گزینه  پس از کلیک  

 کلیک کنید. Okاز آن ها را بسته به نیاز خود انتخاب کرده و بر روی  

 
 تبدیل می شوند.  Endnoteها به  Footnoteدر صورت انتخاب گزینه اول؛ تمامی 

 تبدیل می شوند. Footnoteها به  Endnoteدر صورت انتخاب گزینه دوم؛ تمامی 

تبدیل می   Endnoteها به    Footnoteو تمامی    Footnoteها به    Endnoteو در صورت انتخاب گزینه سوم؛ تمامی  

 شوند.

 کلیک کنید. Insertبه کادر قبل بر می گردید. در این قسمت روی گزینه 
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 (Numbering)شماره گذاری  نحوه تغییر 

قرار دارد و هنگامی    …,1,2,3درج می کنید شماره گذاری به طور پیش فرض در حالت    Footnoteهنگامی که  

قرار دارد. در صورتی که بخواهید   …,i, ii, iiiدرج می کنید شماره گذاری به طور پیش فرض در حالت    Endnoteکه  

 نحوه شماره گذاری را تغییر دهید، به صورت زیر عمل کنید.

 کلیک کنید. روی آیکن   Footnotesر قسمت رفته و د Referencesبه تب 

 
. Endnotesمی خواهید تغییر اعمال کنید و یا روی    Footnotesدر منوی باز شده ابتدا انتخاب کنید که روی  

 گزینه مورد نظر خود را انتخاب کنید. Locationبرای این منظور در قسمت  
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را باز کرده و نحوه شماره گذاری مورد    Number Format، لیست آبشاری مربوط  Formatسپس در قسمت  

 نظر خود را انتخاب کنید.

 
 کلیک کنید.  Insertو در نهایت روی گزینه 
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1-35 Split  )دو بخشی کردن( 

ویرایش  در صورتی که تمایل داشته باشید دو صفحه مختلف از فایل خود را هم زمان مشاهده کنید )مثلً در حال  

ها را نیز مشاهده کنید(. در این صورت   Endnoteیک صفحه خاص هستید و هم زمان تمایل دارید صفحه مربوط به  

 کردن که این امکان را برای شما فراهم می کند.  Splitدر ورد وجود دارد به نام  تیقابلی

 ، این قابلیت را فعال کنید.Split  با کلیک بر آیکن  Windowرفته و در قسمت    Viewکردن به تب    Splitجهت  

 
را فعال می کنید، در قسمت بالا، صفحه ای در آن قرار داشتید و در قسمت پایین اولین    Splitهنگامی که قابلیت  

 صفحه از فایل شما نمایش داده می شود. 
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اندازه دو بخش ایجاد شده را تغییر    Drag & Dropشما می توانید نشانگر ماوس را روی خط جدا کننده برده و با  

 دهید.

 برای خارج شدن از این حالت دو راه وجود دارد: 

، کلیک کرده و آن را غیر  Remove Split  و روی آیکن   Windowرفته و در قسمت    Viewبه تب   ✓

 فعال کنید. 

 

 ننده دو بار کلیک کنید.روی خط جدا ک ✓

1-36 Comment گذاشتن 

در مواقعی که فایل بین دو یا چند نفر در حال تبادل می باشد و افراد تمایل دارند نظر خود در مورد قسمت و یا  

 استفاده می شود.   Commentاز قابلیت قسمت هایی خاص از فایل را به دیگری اطلع دهند، 
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ابتدا قسمتی که می خواهید نظری را درباره آن درج کنید را با ماوس انتخاب کنید و یا    Commentجهت درج  

رفته و در    Reviewنشانگر ماوس را دقیقاً کنار عبارت مورد نظر خود و بدون هیچ فاصله ای قرار دهید. سپس به تب  

 کلیک کنید. New Comment روی آیکن Commentsقسمت 

به رنگ قرمز درآمده و کادری در کنار صفحه شما باز خواهد شد. در کادر نمایش  قسمت انتخاب شده توسط شما 

 داده شده می توانید نظر خود را یادداشت کنید.

 Commentکردن    (Delete)پاک 

را پاک کنید. نشانگر ماوس را روی محدوه رنگی در متن قرار دهید.    Commentدر صورتی که تمایل داشته باشید  

همچنین می توانید روی    کلیک کنید.  Deleteروی آیکن    Commentsدر قسمت  رفته و    Reviewسپس به تب  

 را انتخاب کنید. Deleteکلیک کرده و گزینه   آیکن  

 را انتخاب کنید.   Delete Commentمورد نظر راست کلیک کره و گزینه    Commentهمچنین می توانید روی  

تمامی   باشید  داشته  تمایل  که  صورتی  انتخاب   Commentدر  به  نیازی  کنید،  پاک  را  فایل  در  موجود  های 

Comment    ندارید. تنها کافیست در تبReview  در قسمت ،Comments  کلیک کنید و در    ، روی علمت

 را انتخاب کنید.  Delete All Comments in Documentمنوی باز شده، گزینه 

 ها Commentجابجایی بین 

رفته و در    Reviewها کلیک کنید. سپس به تب  Commentیکی از  ها روی  Commentجهت جابجایی بین 

 روی آیکن های و بسته به نیاز خود کلیک کنید. Commentsقسمت 

 Comment به (Reply)پاسخ دادن  

مورد نظر راست کلیک کرده و گزینه    Commentپاسخ دهید روی    Commentدر صورتی که بخواهید به یک  

Reply to Comment  .را انتخاب کنید و سپس متن خود را یادداشت کنید 

 Commentانجام شدن 

راست    Commentخاصی انجام شده است، روی    commentدر صورتی که بخواهید به فرد دیگر اطلع دهید که  

  Commentدر این صورت قسمت رنگی مربوط به    را انتخاب کنید.  Mark Comment Doneکلیک کرده و گزینه  

 در صفحه به حالت کم رنگ درمی آید.

 (Replace)و جایگزینی   (Find)جستجو  1-37
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 (Find)جستجو 

گاهی اوقات می خواهید عبارت خاصی را در فایل خود جستجو کنید و آن را بیابید. جهت انجام این کار باید از  

  Editingرفته و در قسمت    Homeورد استفاده کنید. برای استفاده از این قابلیت به تب  موجود در نرم افزار    Findقابلیت  

 کلیک کنید. Findروی آیکن 

 
 کادری در سمت چپ صفحه مشاهده خواهید کرد.

آیکن   روی  و  کنید  وارد  شده  داده  نشان  زیر  تصویر  در  که  قسمتی  در  را  خود  نظر  مورد  عبارت 

 .(را از صفحه کلید بفشرید Enterکلیک کنید )و یا کلید   

 نیز استفاده کنید. Ctrl+ Fشما می توانید از کلیدهای ترکیبی 

 

 (Replace)جایگزینی 

قابلیت   از  باید  کار  این  انجام  کنید. جهت  جایگزین  دیگر  عبارتی  با  را  عبارت خاصی  می خواهید  اوقات  گاهی 

Replace    موجود در نرم افزار ورد استفاده کنید. برای استفاده از این قابلیت به تبHome    رفته و در قسمتEditing  

 کلیک کنید. Replaceروی آیکن 
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یل به تغییر آن دارید را یادداشت ، عبارتی که تماFind whatدر خواهد آمد. در قسمت    کادری برای شما به نمایش

 کنید. 

 عبارتی که می خواهید جایگزین عبارت قبلی شود را یادداشت کنید.   Replace withدر قسمت 

کلیک کنید تا عبارت را برای شما بیاید و هنگامی که عبارت را برای شما یافت، در    Find Nextسپس روی گزینه

بودید روی گزینه   از جایگزینی آن ها مطمئن  این صورت مجدداً روی    Replaceصورتی که  کلیک کنید، در غیر 

Find Next .کلیک کنید 

 

 
باشد، و یا در صورتی که به آخرین تکرار عبارت  درصورتی که عبارت مورد نظر شما تنها یک بار در فایل آمده  

 خود در فایل رسیده باشید، کادر زیر برای شما نمایش داده خواهد شد.
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اما اگر هنوز تکرارهایی از عبارت مورد نظر شما باشد که به شما نمایش داده نشده است، نرم افزار عبارت بعدی را  

 ی دارید یا خیر.به شما نشان خواهد داد که تمایل به جایگزین

   Replace Allهای مورد نظر شما در فایل جایگزین شوند، روی گزینه    عبارتدر صورتی که بخواهید تمامی  

 کلیک کنید. در این صورت در پایان جایگزینی ها، گزارشی از اینکه چه تعداد کلمه جایگزین شد به شما داده می شود.

کلیک    Homeدر تب    Replaceه تر انجام دهید، زمانی که روی آیکن  را به طور پیشرفتاگر بخواهید جایگزینی ها  

 کلیک کنید. Moreکردید و کادر زیر برای شما به نمایش درآمد، روی گزینه  

 
کلیک کرده و پس از آن گزینه ای که می خواهید تنظیمات مربوط به    Formatقسمت پایین روی گزینه    درسپس  

 را انتخاب کنید.  Fontثلً تنظیمات مربوط به آن را انجام دهید، انتخاب کنید. م

در این صورت کلمه شما هم جایگزین می شود و هم تنظیمات مربوط به فونت آن تغییر خواهد. اما اگر قسمت  

Replace with    را پر نکنید، تنها تنظیمات مربوط بهFont    کلمه ای که در قسمتFind what   یادداشت کرده اید

 تغییر خواهد کرد. 
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 کادر مربوط به تنظیمات فونت برای شما نمایش داده می شود. کلیک کردید،  Fontهنگامی که روی  

به طور مثال   اعمال کنید.  برای    Italicرا در حالت    Font Styleتنظیمات مورد نظر خود را   Fontقرار داده، 

Color یک  ای  ، رنگ قرمز را انتخاب کرده و برStyle    برایUnderline Style    انتخاب کرده و روی گزینهOk  

 کلیک کنید.
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 را کلیک کنید.  Okکلیک کرده و در نهایت   Replaceسپس روی گزینه 

 
 کلیک کنید. Find & Replaceجهت بستن کادر مربوط به  Closeروی گزینه 
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 فایل ورد رمز گذاری 1-38

I.  فایل ورد رمز گذاری جهت باز کردن 

جهت   اینصورت  در  باشند.  آن  مشاهده  به  قادر  دارند  را  فایل  رمز  که  کسانی  تنها  بخواهید  گاهی  است  ممکن 

 رمزگذاری باید به ترتیب زیر عمل کنید:

و یا کلید  و مکان ذخیره سازی را تعیین کنید  کلیک کنید    Save asاز آن جا بر روی گزینه  رفته و    Fileبه تب  

F12  کلید بفشرید.را از  صفحه 

کلیک    …General Optionsکلیک کنید، و در منوی باز شده روی گزینه    Toolsدر کادر باز شده روی آیکن  

 کنید. 
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، رمز دلخواه خود را برای  Password to openبرایتان باز خواهد شد. در قسمت    General Optionsکادر  

 .کلیک کنید Okباز کردن فایل یادداشت کرده و روی گزینه 
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 کادری باز شده و از شما خواسته می شود که رمز وارد شده را دوباره وارد کنید.
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اهید شد که از شما خواسته می شود جهت  پس از انجام این اقدامات، با بستن و باز کردن مجدد فایل خود، متوجه خو

 باز کردن فایل رمز را وارد کنید.

 
 فایل، از شما رمز عبور باز کردن فایل خواسته می شود. از این پس، با هر بار باز کردن 

II. رمز گذاری جهت ویرایش فایل ورد 

 باید از این قابلیت استفاده کرد.اگر بخواهید که افراد پس از مشاهده فایل، قادر به ویرایش آن نباشند 

 جهت انجام این کار دو مسیر زیر را می توانید دنبال کنید:
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نید. در سمت کلیک ک  Restrict Editing، روی آیکن  Protectقسمت  رفته و در    Reviewبه تب   ✓

  Editing restrictions .2شاهده خواهید کرد. تیک مربوط به قسمت شماره  راست صفحه کادری را م

باز کرده و گزینه   بزنید. مشاهده خواهید کرد که کادر زیرین آن فعال خواهد شد. لیست آبشاری را  را 

Filling in forms  انتخاب کنید. را 

 

قسمت   ✓ گزینه    Start enforcement .3به  روی  و    Yes, Start Enforcing Protectionرفته 

، رمز عبور جدیدی  Enter new password (optional)در قسمت  کلیک کنید. در کادر باز شده،  

س روی  رمز عبور را مجدداً وارد نماید. سپ  Reenter password to confirmوارد کنید و در قسمت  

 کلیک کنید. Okگزینه  
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 و بعد از انجام این کار دیگر قادر به ویرایش فایل نخواهید بود. 

تب   به  مجدداً  فایل،  ویرایش  به  تمایل  صورت  قسمت  Reviewدر  در  و  آیکن  Protect  رفته  روی   ،Restrict 

Editing  .روی گزینه    کلیک کنید. در سمت راست صفحه کادری را مشاهده خواهید کردStop Protection    کلیک

 Okکنید. کادری را مشاهده خواهید کرد که از شما رمز عبور می خواهد. رمز ویرایش را وارد کرده و روی گزینه  

 کلیک کنید.

 

افظت جهت ویرایش را ندارد و شما باید مجدداً جهت رمز کردن فایل، دیگر فایل شما قابلیت مح   Unprotectبا هر بار  

 گذاری ویرایش فایل اقدام نمایید.

 مسیر زیر را نیز می توانید دنبال کنید: Restrict Editingتوجه: جهت باز شدن کادر  

تب   قسمت    Fileبه  در  آیکن  Infoرفته،  روی   ،Protect Document   گزینه شده  باز  منوی  در  کنید.  کلیک 

Restrict Editing  .را انتخاب کنید 

 در ورد  Mailingقابلیت  1-39

به تب   قابلیت  این  از  استفاده   Select، روی آیکن  Start Mail Mergeرفته و در قسمت    Mailingجهت 

Recipients    گزینه    کنید. در منوی باز شده اگر فایل آماده ای از داده ها نداریدکلیکType a New List    را

فایل آماده ای از داده ها و در قالب و در صورتی که    داده ها را تولید خواهید کرد  Accessکه با برنامه    انتخاب کنید

 کلیک کنید. Use an Existing Listدارید روی گزینه  Excelفایل 
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Mailing  با استفاده ازAccess 

در صورتی    را مشاهده خواهید کرد.  New Address List، کادر  Type a New Listپس از انتخاب گزینه  

کلیک کنید. با کلیک بر   Customize Columnsروی گزینه  که تمایل داشته باشید عناوین ستون ها را تغییر دهید،  

را    Titleبرای مثال گزینه    بنابر نیاز خود نام ستون ها را تغییر دهید.ویرایش نام ستون ها وجود دارد.  این گزینه امکان  

 "عنوان "را به    To  ،Titleدر قسمت    Rename Fieldکلیک کنید. در کادر    Renameانتخاب کنید، روی عبارت  

 کلیک کنید.  Okتغییر دهید و روی گزینه 

 
شتید کنید. در صورتی که به تعداد ستون بیشتری نیاز دا  Renameبه همین صورت هر تعداد ستونی که نیاز دارید را  

این کار را انجام دهید. و همینطور اگر نیازی داشتید که ستونی را حذف کنید، پس از    Addمی توانید با کلیک بر گزینه  

 را انتخاب کنید.  Deleteانتخاب ستون مورد نظر، گزینه 

و    Move Upجهت جابجایی ستون ها، ابتدا ستون مورد نظر خود را انتخاب کرده، بنابر نیاز خود روی گزینه های  

Move Down  کلیک کنید. در نهایت روی گزینهOK  .کلیک کنید 
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کلیک    New Entryی خود را وارد کنید. جهت اضافه کردن ردیف روی گزینه  سپس در ردیف اول داده ها 

 کلیک کنید. Delete Entryکنید. و در صورت تمایل به حذف ردیف، ابتدا آن را انتخاب نموده سپس روی گزینه  
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 کلیک کنید. Okدر نهایت روی گزینه داده های خود را وارد نمایید.  

 
برای شما باز می شود. در اینجا   Save Address Listکلیک کردید، کادر    Okبلفاصله پس از اینکه بر گزینه  

 کلیک کنید. Saveداده های خود را تعیین کرده و روی گزینه  Accessباید محل ذخیره سازی فایل  
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 آماده کرده و برای درج داده ها اینگونه عمل کنید.   سپس متن خود را

رفته، در قسمت   Mailing تبه  سپس ب  درج شود قرار دهید.در آن جا  دارید داده    مکان نما را در جایی که تمایل

Write & Insert Fields  روی آیکن ،Insert Merge Field   .عنوان ستون مورد نظر خود را انتخاب    کلیک کنید

 کنید. 
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 به همین صورت تمامی عناوین ستون ها را در جای مناسب آن درج کنید.

 
 کلیک کنید. Preview Resultsجهت مشاهده داده های خود، روی آیکن 

 
مشاهده می کنید که داده های ردیف اول برایتان نمایش داده می شود. برای اینکه دیگر داده های خود را مشاهده  

 ، روی آیکن کلیک کنید.Preview Resultsکنید در قسمت 

 
  Finishده شوند و آن ها را در فایلی جداگانه داشته باشید، به قسمت  اگر بخواهید تمامی داده های شما نمایش دا

را انتخاب   Edit Individual Documentsکلیک کنید و از آن جا گزینه    Finish & Mergeرفته و روی آیکن  

 کنید. 

 
 را مشاهده می کنید.  Merge to New Documentبا کلیک بر این گزینه، کادر  
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 گزینه دارید.در این کادر سه 

 با انتخاب گزینه اول تعیین می کنید که از تمامی داده هایتان در فایلی جداگانه خروجی بدهد.

انتخاب گزینه دوم تعیین می کنید که از ردیفی از داده ها که در حال نمایش روی صفحه است در فایلی جداگانه   با 

 خروجی بدهد.

 چند برای شما خروجی بدهد.ردیف چند تا شماره می کنید که از ردیف  و با انتخاب گزینه سوم تعیین

 کلیک کنید. Okسپس روی گزینه  گزینه مورد نظر خود را انتخاب و 

را کلیک    Ok، یعنی ردیف داده های درحال نمایش را انتخاب کنید و گزینه  (Current record)برای مثال گزینه دوم  

 کنید. 

 ر فایلی جداگانه برایتان خروجی داده می شود. از صفحه ی در حال نمایش، د 

 

Mailing  با استفاده ازExcel 
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، ابتدا باید فایلی آماده از داده های  Mailingبرای    Excelهمانطور که قبلً آموزش داده شد، جهت استفاده از  

 خود داشته باشید.

 

 
، کادر زیر را مشاهده می  Use an Existing Listو انتخاب گزینه    Select Recipientsپس از کلیک بر آیکن  

 کلیک کنید.  Openکنید که از شما می خواهد فایل داده هایتان را انتخاب کرده و روی گزینه 
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که    (Sheet)، کادر زر باز خواهد شد و از شما خواسته می شود که کاربرگی  Openبلفاصله پس از کلیک بر گزینه  

 کلیک کنید. Okداده های شما در آن موجود است را انتخاب کرده و روی گزینه  

 در صورتی که تیک پایین صفحه را بزنید، اولین ردیف، شامل سربرگ های ستون های زیرین خواهد شد.
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رفته، در قسمت   Mailingل دارید داده در آن جا درج شود قرار دهید. سپس به تب مکان نما را در جایی که تمای 

Write & Insert Fields  روی آیکن ،Insert Merge Field     کلیک کنید. عنوان ستون مورد نظر خود را انتخاب

 کنید. 

 

 
 انجام دهید.  Accessبا استفاده از  Mailingمراحل بعدی را مانند به 
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  Microsoft PowerPointآموزش واژه پرداز  -2

 PowerPointروش های باز کردن فایل   2-1

هنگامی که فایل برای شما باز    ست. ، مشابه روش باز کردن دیگرفایل های پیشین اPowerPointروش باز کردن فایل  

 کلیک کنید. Blank Presentationشد، روی گزینه 

 مواردی که رعایت آن ها در پاورپوینت ضروری است:  2-2

I. .پاورپوینت باید فهرست داشته باشد و فهرست آن دارای لینک های رفت و برگشتی باشد 

II. .اسلیدها با موضوع ارائه تناسب داشته باشند 

III.  متحرک سازی(Effect)  .ها با موضوع ارائه متناسب باشند 

 داریم: Effectنوع  2

- Effect   .هایی که مربوط به خود اسلیدها می باشد(Transitions) 

- Effect    .هایی که مربوط به محتوا )متن، عکس، جدول، نمودار و ...( می باشد(Animations) 

IV.   ،حتماً ارائه آزمایشی انجام شود تا از صحت نمایش محتوا بر پرده نمایش اطمینان حاصل قبل از ارائه اصلی

 کنید. 

 اصل اول در ایجاد هر فایل پاورپوینت  2-3

پاورپوینت،   فایل  هر  ایجاد  در  اول  پیشاصل  طور  به  اسلیدهاست.  سایز  حالت  فرض    تنظیم  در  اسلیدها  سایز 

Widescreen  قرار دارد. این سایز برای مشاهدهSlide  هدف اصلی از ایجاد  ها در صفحه مانیتور مناسب می باشد. اما

آپاورپوینت،    فایل نمایش  و  دادن  سایز  ارائه  اگر  و  باشد  می  پروژکتور  ویدیو  روی  بر  در    Slideن  حالت ها 

Widescreen  از کل ظرفیت پرده نمایش استفاده نخواهد شد. به همین دلیل باید از حالت  باشد ،Standard   استفاده

 کرد. جهت انجام این کار، مسیر زیر را دنبال کنید:

کلیک کنید. در منوی باز شده، حالت   Slide Sizeروی آیکن  Customizeرفته و در قسمت  Designبه تب  

Standard  .را انتخاب کنید 
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 ، کادر زیر را مشاهده خواهید کرد:Standardبلفاصله پس از انتخاب حالت 

 
ا اسلید را داشته  از شما پرسیده می شود که آیا تمایل دارید سایز داده های شما بزرگنمایی شود و یا حالت متناسب ب

 گزینه دوم باید عاقلنه باشد. باشد. انتخاب 

 های شما، حالت استاندارد به خود خواهند گرفت. Slideایز و پس از س
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 چگونگی ایجاد صفحات جدید  2-4

 های جدید، سه راه وجود دارد:  Slideجهت ایجاد 

را از صفحه    Enterایجاد کنید، کلیک کرده و کلید    Slideروی اسلیدی که می خواهید پس از آن   ✓

 .(لید جدید از نوع اسلید قبلی خواهد بودکلید بفشارید. )اس

  New Slideایجاد کنید، راست کلیک کرده و گزینه    Slideروی اسلیدی که می خواهید پس از آن   ✓

 .( لید جدید از نوع اسلید قبلی خواهد بودرا انتخاب کنید. )اس
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کلیک کنید. منویی باز خواهد شد    New Slide، روی آیکن  Slidesرفته و در قسمت    Homeبه تب   ✓

 انتخاب کنید.  جدید  Slide گزینه ای را برای نوعو شما می توانید
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 Themeتغییر   2-5

مورد نظر خود را انتخاب   Themes ،Themeرفته و در قسمت   Designاسلیدها، به تب    Themeجهت تغییر  

 کنید. 

 
 دهید، به صورت زیر عمل کنید:  Themeها را تغییر   Slideایل داشته باشید یکی از اگر تم

یا اسلیدهایی که می خواهید    Slideابتدا   انتخاب چند  آن ها متفاوت    Themeو  انتخاب کنید. جهت  را  باشد 

 بعدی را انتخاب کنید.  Slideرا نگه داشته سپس   Ctrlاسلید با هم ابتدا کلید 

 را انتخاب کنید. Apply to Selected Slidesمورد نظر راست کلیک کرده و گزینه   Themeروی  
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را انتخاب نکنید، با کلیک    Apply to Selected Slidesتوجه داشته باشید که اگر راست کلیک نکنید و گزینه  

انتخاب می شود و همه اسلیدهای شما   Apply to all Slidesجدید، به طور پیش فرض گزینه    Themeکردن روی  

Theme .جدید به خود خواهند گرفت 

 Themeتغییر رنگ 

 اما با رنگی متفاوت باشد به صورت زیر عمل کنید: Themeاگر تمایل داشته باشید که اسلید شما دارای یک  
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اسلید و یا اسلیدهایی که تمایل دارید رنگ آن ها متفاوت باشد را انتخاب کنید. اگر می خواهید تمامی اسلیدهایی  

تغییر رنگ    خاص دارند را تغییر رنگ دهید نیازی به انتخاب کردن نیست و با کلیک بر یکی از آن ها،  Themeکه یک  

 شد.  یکسان اعمال خواهد Themeبرای تمام اسلیدهای با  

یکی از رنگ ها را انتخاب کنید. روی آن راست کلیک کرده و    Variantsرفته و در قسمت    Designبه تب  

 یکی از سه گزینه را با توجه به نیاز خود انتخاب کنید.

 
یکسان با اسلید مورد نظر هستند،   Themeدر صورتی که گزینه اول را انتخاب کنید، تمامی اسلیدهای که دارای  

رنگ خواهند داد. )در صورتی که روی رنگ مورد نظر راست کلیک نکنید و تنها کلیک کنید، این گزینه به طور   تغییر

 پیش فرض اعمال می شود.( 

یکسان باشند و یا    Themeدر صورتی که گزینه دوم را انتخاب کنید، تمامی اسلیدهای فایل شما، خواه دارای  

ک روی آن انجام شده است به تمامی اسلیدها منتقل خواهد شد و تمامی مربوط به اسلیدی که کلی  Themeمتفاوت،  

 آن ها نیز به رنگ مورد نظر در می آیند.

در صورتی که گزینه سوم را انتخاب نمایید، تنها اسلید و یا اسلیدهای انتخاب شده توسط شما تغییر رنگ خواهند  

 داد.

 Themeدرج تصویر جهت 

 ت زیر عمل کنید.داشته باشید که پس زمینه اسلیدهای شما تصویر خاصی باشد به صوردر صورتی که تمایل 
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کلیک کنید. کادر مربوط به    Format Backgroundروی آیکن    Customizeرفته و در قسمت   Designبه تب  

 در کنار صفحه باز خواهد شد. Backgroundتنظیمات 

 

 

 کم رنگ کردن تصویر پس زمینه

 تمایل داشته باشید می توانید پس زمینه را کم رنگ کرده که متن نوشته شده واضح دیده شود.در صورتی که 



 

119 

 

انتخاب ،  Format Backgroundکنید، در کادر    جهت انجام این کار اسلید و اسلیدهای مورد نظر خود را 

ظر خود را در کادر  عدد مورد نکلیک کرده و آن را به جلو بکشید. همچنین می توانید    Transparencyروی خط  

 را از صفحه کلید بفشارید.   Enterروبه روی آین یادداشت کرده و کلید 

 
آن    باگر تمایل دارید تمامی اسلیدهای شما دارای تصویر خاص و انتخابی شما در پس زمینه باشند نیازی به انتخا

 Applyگزینه    Format Backgroundدر قسمت پایین کادر  ها نیست، تنها کافی است پس از انجام اقدامات لازم،  

to All   .را انتخاب کنید 

ن ها را انتخاب کرده و سپس  تدا آاسلیدهای مورد نظر خود هستید، اباما در صورتی که مایل به اعمال به اسلید و یا  

 اقدامات را انجام دهید. 

 Slideتنظیمات اولیه مربوط به یک  2-6

)راست نویس( و جهت   Right to Leftجهت متون فارسی و یا ترکیبی از متن فارسی و لاتین در حالت  ✓

 )چپ نویس( قرار داشته باشید. Left to Rightمتون لاتین در حالت 

می باشد و    2و سری    Bجهت متون فارسی از فونت های فارسی که معروف ترین آن ها مربوط به سری   ✓

 استفاده کنید. Times New Romanت های لاتین مانند جهت متون لاتین از فون

وجود    Wordوجود دارد و در    PowerPointگزینه ای که در    ،"امکان سایه دادن جهت متن انتخابی" ✓

رفته و    Font، قسمت  Homeندارد. جهت استفاده از این قابلیت، ابتدا متن خود را انتخاب کنید، به تب  
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کلمه آموزش دارای  سمت راست،  نوشته  که مشاهده می کنید، برای  روی  آیکن کلیک کنید. همانطور  

 سایه می باشد. 

 

 چگونگی اعمال تنظیمات مربوط به یک اسلاید به اسلایدهای جدید  2-7

چون در نرم افزار پاورپوینت نمی توان در تمامی اسلیدها به طور همزمان تغییر فونت اعمال کرد، بهتر است ابتدا در  

 انجام شود.  Copy & Pasteیک اسلید خالی و بدون متن تغییر فونت را اعمال کرده و سپس از آن اسلید 

انجام دهید.    Copy & Paste، از یک اسلید یک  Ctrl + Dمی توانید با یک بار استفاده از کلیدهای ترکیبی  

 را اضافه کنید. Ctrl + Dبه تعداد اسلیدهایی که نیاز دارید اضافه شود، کلیدهای 

 اعمال شده را دیگر اسلیدها نیز خواهید داشت.با این کار تمامی فونت ها و تنظیمات 

 چگونگی جابجایی اسلایدها  2-8

دها، ابتدا آن ها را انتخاب کرده، سپس آن ها را به جای مورد نظر بکشید و رها  جهت جابجایی اسلید و یا اسلی

(Drag & Drop) .کنید 

2-9 Comment   )گذاشتن )نظر 
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، سپس همانطور که در شکل  روی یک اسلید، ابتدا اسلید مورد نظر را انتخاب کرده  Commentجهت درج  

پایین صفحه روی آیکن   فعال شدن کادر    Commentنشان داده شده، در  با  و  در کنار    Commentکلیک کرده 

 یک کنید.کل New Commentصفحه، روی آیکن 

 
Comment    خود را در جای نشان داده شده در شکل یادداشت کنید. همانطور که در شکل می بینید، هر اسلیدی

 روی آن، در گوشه بالا، سمت چپ درج خواهد شد.  Commentدر آن درج شده باشد، آیکن  Commentکه 

 

 )یادداشت(  Noteدرج  2-10
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کلیک کنید. در    Notes، روی آیکن  Commentروی هر اسلید، پایین صفحه کنار آیکن    Noteجهت درج  

 د توضیحات خود را در آن یادداشت کنید.این صورت کادر در پایین اسلید مشاهده خواهید کرد که می توانی

 

2-11 Transitions ( اعمالEffect جهت اسلایدها ) 

خاصی در صفحه حرکتی  در صورتی که تمایل داشته باشید اسلیدهای خود را متحرک سازی کنید تا با جلوه های  

 ظاهر شوند به صورت زیر عمل کنید. 

را خود  نظر  مورد  اسلیدهای  یا  و  اسلید  کنید.  ابتدا  تب    انتخاب  به  قسمت    Transitionsسپس  در  و   رفته 

Transitions to This Slide ،  .از بین گزینه های موجود، یکی را به دلخواه خود انتخاب کنید 

  *پس از اینکه جلوه حرکتی خاصی را به اسلید مورد نظر خود اختصاص دادید، در کنار اسلید شما، یک علمت  

 درج خواهد شد. 
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خاص     Effect، از بین گزینه های مختلف، حالت های مختلف یک Effect Optionsمی توانید با کلیک بر آیکن  

 را مشاهده و آن را انتخاب کنید.

 

 صداگذاری بر روی اسلاید 

، لیست آبشاری مربوط به آن را باز نموده  Soundsبا کلیک بر آیکن    Timing، در قسمت  Transitionsدر تب  

 زینه ها را انتخاب کنید. و یکی از گ

 اسلید شما هنگام ظاهر شدن، صدای مربوط به گزینه انتخابی شما را خواهد داشت. 

در لیست آبشاری باز شده، فایل صوتی مورد نظر خود را   Other Soundشما همچنین می توانید با انتخاب گزینه 

 از سیستم خود آپلود کنید.
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 Effectمدت زمان اجرای 

انتخابی شما، متفاوت است. در صورت تمایل    Effect، به طور پیش فرض با توجه به  Effectمدت زمان اجرای هر  

، Transitionتر کنید. جهت انجام این کار، در تب    را کوتاه تر و یا طولانی  Effectمی توانید مدت زمان اجرای یک  

 را با توجه به خواسته خود، کم و یا زیاد کنید.  Duration، عدد نوشته شده در مقابل آیکن Timingدر قسمت 

 

Advance Slide  )پیشروی اسلایدها( 

تب   در  اسلیدها  پیشروی  چگونگی  تعیین  قسمت  Transitionsجهت  به   ،Timing    مجموعه زیر  در  بروید. 

Advance Slide    با تیک دار کردن گزینهOn Mouse Click    به طور پیش فرض  نیز فعال است(، )این گزینه 

اسلید بعدی ظاهر سلید،  با کلیک کردن روی هر ا  ،قرار دارید  Slide Showانتخاب می کنید زمانی که در حالت  

در صورتی که این تیک را بردارید، با کلیک کردن، اسلید بعدی ظاهر نمی شود. در این صورت جهت جابجایی   شود.

 بین اسلیدها می توانید از کلیدهای صفحه کلید استفاده کنید.
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،  معین از گذشت مدت زمانی  را تیک دار کنید، تعیین می کنید که بعد    Afterو همینطور درصورتی که گزینه  

 وارد کنید. Afterاسلید بعدی ظاهر شود. شما می توانید مدت زمان مورد نظر خود را در کادر روبه روی آیکن  

 
باشید داشته  تمایل  قسمت    اگر  به  مربوط  تنظیمات  قسمت Timingتمامی  در  شود،  اعمال  نیز  اسلیدها  تمامی  در   ،

Timing  روی عبارت ،Apply to All  .کلیک کنید 

 

2-12  Animations  اعمال(Effect جهت محتوا ) 

ها را به دلخواه    Effectرفته و یکی از    Animationsاز محتوا را انتخاب کنید. به تب  متن، تصویر و یا هر قسمتی  

 انتخاب کنید. 
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 اختصاص داده بودید شماره قرار می گیرد. Effectدر کنار محتوایی که به آن  

انتخابی خود را می توانید مشاهده کنید    Animation، حالت های مختلف  Effect Optionsبا استفاده از گزینه  

 و در صورت تمایل آن ها را انتخاب کنید. 
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،  Animationب  در ت  Animationانتخابی خود را تغییر دهید، از قسمت    Animationدر صورتی که بخواهید  

 یک مورد دیگر را می توانید انتخاب کنید. 

 
آیکن  را روی محتوای انتخابی خود اعمال کنید، روی    Animationدر صورتی که تمایل داشته باشید بیش از یک  

Add Animation    در قسمتAdvanced Animation    کلیک کنید و یکAnimation    را به دلخواه اعمال

 کنید. 
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شماره برای یک    Add Animation  ،2دیگر، از قسمت    Animationمشاهده می کنید که پس از اضافه کردن یک  

 می باشد. Animation 2محتوا در اسلید درج خواهد شد و این به این معنی است که محتوای انتخابی شما دارای  

 
، به  Animationsهایی را که اعمال می کنید ببینید، در تب    Effectنمایش    در صورتی که تمایل داشته باشید پیش

آن را فعال کنید، هنگامی که فعال شود یک علمت تیک    AutoPreviewرفته و با کلیک بر گزینه    Previewقسمت  

 کنار آن درج خواهد شد. 
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حه برای شما نمایش داده شود، در تب  ها در کنار صف Effectدرصورتی که تمایل داشته باشید تنظیمات مربوط به 

Animation  به قسمت  ،Advanced Animation    بر آیکن با کلیک  آن را فعال   Animation Paneرفته و 

 کنید. 

 
، در جایی Animation Paneدر این قسمت می توانید تنظیمات بیشتری را اعمال کنید. برای مثال در کادر باز شده ی  

روی گزینه  ها راست کلیک کرده و در منوی باز شده    Animationها را نشان داده روی یکی از    Animationکه  

Effect Options  .کلیک کنید 
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 کادر زیر را مشاهده خواهید کرد.

 
قرار    (none)را باز کنید. به طور پیش فرض در حالت    Repeat، لیست آبشاری مقابل گزینه  Timingدر تب  

 دارد. با انتخاب هر کدام از گزینه ها تعداد تکرار و یا چگونگی تکرار را تعیین کنید.

، تنظیمات مربوط به متن را انجام دهید که متن به صورت حرف حرف و یا کلمه  Text Animationو در تب  

 کلمه ظاهر شود. 

 
 کلیک کنید.  Okسپس روی گزینه 

 Effectنمایش   شروع  تنظیم زمان
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چه زمانی شروع شود. همانطور که    Animationتعیین می کنید    Start، با استفاده از آیکن  Timingدر قسمت  

 در اختیار دارید. Animationدر تصویر مشاهده می کنید، سه گزینه برای زمان شروع 

اجرا خواهد    Animationکه شما با ماوس کلیک کنید،    ، در صورتی(On Click)در صورت انتخاب گزینه اول  

 شد.

 ، همزمان با عملیات قبل از خود اجرا می شود.(With Previous)در صورت انتخاب گزینه دوم 

 ، بعد از عملیات قبل از خود اجرا می شود.(After Previous)در صورت انتخاب گزینه سوم 

 Effectتنظیم مدت زمان نمایش 

، با استفاده  Timingرا زیاد و یا کم کنید، در قسمت    Effectدر صورتی که تمایل داشته باشید مدت زمان یک  

 ، زمان پیشنهادی خود را وارد کنید.Durationاز آیکن 

 Effectتنظیم ایجاد تاخیر در اجرای 

با تاخیر اجرا شود،  انتخابی ش  Effectمایل داشته باشید  تدر صورتی که   ،  Timingمیزان تاخیر را در قسمت  ما 

انتخاب کرده، و در    On Click، گزینه  Startوارد کنید. )برای مثال فرض کنید در قسمت    Delyمقابل آیکن   را 

 اجرا خواهد شد.   Animationثانیه پس از کلیک،   2را وارد کرده اید. در این صورت  Dely 2قسمت 

 پاورپوینت را می توان با فرمت های مختلفی ذخیره کرد فایل   2-13

را از صفحه    F12کلید  داده شد،    ، آموزش Wordنگونه که در قسمت  جهت تغییر فرمت فایل پاورپوینت، ابتدا هما

با نمایش کادر   بفشارید.  به قسمت  Save Asکلید  باز کرده و فرمت را    Save As Type، لیست آبشاری مربوط 

 انتخاب نمایید.  دلخواه خود را

 بررسی برخی از فرمت ها

- PowerPoint Presentation (*.pptx)  ←  به بعد  2010فایل پاورپوینت تهیه شده در ورژن های 

- PowerPoint 97-2003 Presentation (*.ppt)  ← 2007الی  2003 فایل تهیه شده در ورژن 

- PDF (*.pdf)  ←  فایلPDF 

- PowerPoint Show (*.ppsx) ←  حالتSlied Show 

- MPEG-4 Video (*.mp4) ←  با فرمتMp4 

 حفظ فونت ها و تغییر پیدا نکردن آن ها هنگام جابه جایی فایل  2-14
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هنگامی که فایل پاورپوینت  را در دستگاهی ایجاد کردید، ممکن است مایل به اشتراک گذاری فایل خود باشید،  

جه شوید، جهت جلوگیری از این به هم ریختگی باید فونت ها را حفظ اما با تغییر فونت هنگام به اشتراک گذاری موا

 کرد. برای انجام این کار دو مسیر وجود دارد. مسیرهای زیر چگونگی انجام این کار را نشان می دهد: 

✓ File → Options → Save → Preserve fidelity when sharing this document →  

 Embed fonts in the file 

✓ F12 → Tools → Save Options → Preserve fidelity when sharing this 

document →   Embed fonts in the file 

 آموزش داده شد. Wordدقیقاً به همان صورت که در قسمت 

 فایل پاورپوینت رمزگذاری جهت باز کردن  2-15

جهت   اینصورت  در  باشند.  آن  مشاهده  به  قادر  دارند  را  فایل  رمز  که  کسانی  تنها  بخواهید  گاهی  است  ممکن 

 رمزگذاری باید به ترتیب زیر عمل کنید:

کلیک کنید و مکان ذخیره سازی را تعیین کنید و یا کلید    Save asرفته و از آن جا بر روی گزینه    Fileبه تب  

F12  صفحه کلید بفشرید. را از 

کلیک    …General Optionsکلیک کنید، و در منوی باز شده روی گزینه    Toolsدر کادر باز شده روی آیکن  

 کنید. 

 
، رمز دلخواه خود را برای  Password to openبرایتان باز خواهد شد. در قسمت    General Optionsکادر  

 کلیک کنید. Okباز کردن فایل یادداشت کرده و روی گزینه 
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 کادری باز شده و از شما خواسته می شود که رمز وارد شده را دوباره وارد کنید.

 
هت  پس از انجام این اقدامات، با بستن و باز کردن مجدد فایل خود، متوجه خواهید شد که از شما خواسته می شود ج

 باز کردن فایل رمز را وارد کنید.

 
 از این پس، با هر بار باز کردن فایل، از شما رمز عبور باز کردن فایل خواسته می شود. 

2-16 Slideshow 

 از این قابلیت زمانی که می خواهید فایل پاورپوینت خود را روی پرده نمایش نشان دهید، استفاده می شود. 
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 رفتن وجود دارد:  Slideshowسه راه برای به حالت 

 )مطابق شکل( کلیک کنید. Slideshowدر قسمت پایین فایل پاورپوینت، روی آیکن مربوط به  ✓

 
 از همان اسلید شروع خواهد شد.   Slideshowدر هر اسلیدی قرار داشته باشید، 

 موجود در صفحه کلید استفاده کنید. F5از کلید  ✓

 از اولین اسلید موجود در فایل شما شروع خواهد شد. F5 ،Slideshowبا استفاده از کلید 

 استفاده کنید. Shift + F5از کلیدهای ترکیبی  ✓

از همان اسلیدی که در آن قرار دارید، شروع   Shift + F5  ،Slideshowدر صورت استفاده از کلیدهای ترکیبی  

 خواهد شد.

 شت لینک های رفت و برگ  2-17

 مخصوصاً در ایجاد فهرست جهت پاورپوینت استفاده زیادی می شود. از این قابلیت

 می خواهید یک فهرست ایجاد کنید: فرض کنید

 آموزش داده شد، یک فهرست رسم کنید.  Word)به همان صورت که در    SmartArtابتدا می توانید با استفاده از  

 یادداشت کنید.تمامی عناوین فایل خود را در آن 

کلیک    Hyperlinkسپس روی کادر مربوط به هر عنوان رفته، راست کلیک کنید. در منوی باز شده، روی عبارت  

 کنید. 
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،  Link toرا مشاهده خواهید کرد. ابتدا از قسمت    (Insert Hyperlink)، کادر زیر  Hyperlinkبا کلیک بر گزینه  

 گزینه پیش رو را انتخاب کنید.  4ید. شما باید یکی از تعیین کنید که به خواهید به کجا لینک ده

 گزینه اول: لینک به یک فایل موجود در سیستم و یا یک صفحه وب

 گزینه دوم: لینک به مکانی در این سند 

 ایجاد یک سند جدید گزینه سوم: 

 گزینه چهارم: لینک به آدرس ایمیل

 که در این جا گزینه دوم انتخاب می شود.

شما خواسته می شود مکان مورد نظر در سند را جهت لینک دادن تعیین کنید. در این مثال اسلید سوم انتخاب  سپس از  

 شده است. در سمت راست کادر می توانید پیش نمایشی از اسلید انتخاب شده را مشاهده کنید. 

 کلیک کنید. Okدر نهایت روی گزینه 
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  Slideshowرا فشار دهید. به حالت    Ctrl + F5کلید های ترکیبی  به اسلید مربوط به فهرست بازگردید. حال  

اختصاص داده بودید بروید. مشاهده می کنید که با کلیک بر آن به   Hyperlinkمی روید. حال روی کادری که به آن  

 اسلید سوم منتقل می شود. 

ت تمایل داشته باشید مجدداً به صفحه  در اینجا پس از اینکه مشاهده اسلید لینک داده شده به پایان رسید، ممکن اس

 و آن را به اسلید فهرست لینک دهید. رسم نمایید  Shapeبرای برگشتن باید یک  فهرست بازگردید.

 رسم کنید.  Shapeخارج شوید و در اسلید سوم   Slideshowاز حالت 

را از صفحه کلید بفشارید. اسلید شماره سه را انتخاب کنید.   Esc، کلید  Slideshowجهت خارج شدن از حالت  

 Shapeکلیک کنید. جهت لینک دادن، از بین  Shape، روی آیکن Illustrationsرفته و در قسمت   Insertبه تب 

ها   Shapeبرای لینک دادن مناسب ترین هستند. یکی از     Action Buttonsهای ردیف آخر با عنوان    Shapeها،  

 ه دلخواه انتخاب کنید.را ب 

 کادر زیر را مشاهده خواهید کرد.
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مورد نظر خود را انتخاب کردید، با نشان گر ماوس به شکل علمت جمع در می آید.   Action Buttonهنگامی که  

 را رسم نمایید.  Action Buttonکردن   Drag & Dropدر جای مورد نظر خود، یک کلیک کرده و با  

 که خود شامل دو تب زیر است، فعال می شود. Action Buttonرا رها کردید، کادر   ن که ماوسبه محض ای

قرار دارید،    Slideshow: در صورتی که از این تب استفاده کنید، هنگامی که در حالت  Mouse Clickتب   (1

داده اید منتقل   Linkموجود در صفحه کلیک شود تا عمل کند و به جایی که    Action Buttonباید روی  

 شوید.

قرار دارید،    Slideshow: در صورتی که از این تب استفاده کنید، هنگامی که در حالت  Mouse Overتب   (2

  Linkموجود در صفحه بروید تا عمل کرده و به جایی که    Action Buttonتنها کافی است با ماوس روی  

 داده اید منتقل شوید و نیاز به هیچ اقدام دیگری ندارید.
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داده شده است. با توجه به    Hyperlink  (First Slide)به طور پیش فرض تب اول فعال است و به اسلید اول  

 داده شده متفاوت خواهد بود. در   Hyperlinkرا انتخاب کنید، اینکه به کدام اسلید    Action Buttonاینکه کدام  

را تیک دار کنید و در صورتی که بخواهید به اسلید دلخواه    Noneصورتی که بخواهید آن را غیر فعال کنید باید گزینه  

تیک دار باشد. سپس لیست آبشاری مربوط به آن را باز    Hyperlink toدهید، ابتدا باید گزینه    Hyperlinkدیگری  

 را انتخاب کنید.   …Slideکرده و گزینه  
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دلخواه    Slideبرای شما فعال خواهد شد. شما باید    Hyperlink to Slide، کادر  …Slideپس از انتخاب گزینه  

، پیش نمایش اسلیدی را که انتخاب نموده اید،  Previewخود را انتخاب نمایید. در سمت راست کادر، در قسمت  

 ، کلیک کنید.Okنشان داده می شود. سپس روی گزینه 

 
 کلیک کنید. Okادر قبل باز می گردید، در آن جا نیز روی گزینه مجدداً به ک

آموزش داده شده است، در صورت تمایل به استفاده از تب   (On Mouse Click)وی تب اول در تصویر بالا، ر

On Mouse Overمانند همین تب خواهد بود، تنها کافیست در ابتدا گزینه    ، تمامی مراحلHyperlink    را تیک دار

 کنید. 

رسم شده، به اسلید فهرست   Action Buttonباشید، با کلیک روی    Slideshowحال هنگامی که در حالت  

 منتقل می شوید.

2-18 Slide Master 

ساده ترین    ا آخرین اسلید ادامه داشته باشد،و ت  خاص شروع  از یک اسلید  خاصدر صورتی که بخواهید تغییری  

با استفاده از این قابلیت، شما  Slide Masterراه استفاده از قابلیت   تغییرات مورد نظر )اعم از   کافی است  می باشد. 

اعمال   تصویر،  درج  شکل،  ر  Effectکشیدن  را   )... تمامی  و  روی  خودکار  طور  به  و  دهید  انجام  اسلید  یک  وی 

 هایتان اعمال خواهد شد.اسلید 

 جهت استفاده از این قابلیت مسیر زیر را دنبال کنید:

به تب    slideابتدا   انتخاب کرده،    Slide Master، رو آیکن  Master Viewsرفته و در قسمت    Viewرا 

 کلیک کنید.
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 زش عالی گناباد باشند.برای مثال فرض کنید مایل باشید از اسلید دوم بعد، تمامی اسلیدها دارای آرم مجتمع آمو

 
صفحه شما به شکل    فعال می شود و  Slide Masterتب جدیدی به نام    ،Slide Masterو پس از انتخاب گزینه  

 زیر در می آید: 

 
، درج  (Insert → Picture)آموزش داده شد    Wordآرم را به صورت درج تصویر، همانگونه که در قسمت  

 کنید. 
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 کلیک کنید.  Close Master Viewبازگشته و روی آیکن  Slide Masterسپس به تب 

 
 مشاهده می کنید که تمامی اسلیدها دارای آرم مجتمع آموزش عالی گناباد می باشند. 

 

 درج شماره صفحه  2-19
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 جهت درج شماره صفحه در اسلیدها مسیر زیر را دنبال کنید.

تب   قسمت    Insertبه  در  و  آیکن  Textرفته  روی   ،Slide Number    کادر کنید.   Header andکلیک 

Footer  فعال خواهد شد. تیکSlide Number .را بزنید 

 
 های مختلف، محل قرار گیری شماره صفحه متفاوت است. Themeدر 

شما می توانید در هر اسلید به طور مستقیم هرگونه تغییراتی روی شماره صفحه اعمال کنید و نیازی به وارد شدن به 

 ندارید. Header and Footerتنظیمات 

 درج فیلم در پاورپوینت  2-20

ه،  کلیک کرده و در منوی باز شد   Video، روی آیکن Mediaرفته و در قسمت    Insertجهت درج فیلم به تب  

، و یا از دستگاه (…Online Video)را از اینترنت جستجو کرده و درج کنید    Videoانتخاب کنید که می خواهید  

 برای مثال گزینه دوم را انتخاب کنید.  آن را انتخاب کنید. (…video On My PC)کامپیوتر 
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 کلیک کنید. Insertروی گزینه دلخواه خود را انتخاب کنید. پس از انتخاب   Videoاز شما خواسته می شود که  
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 درج فیلم را انجام دهید. Drag & Dropهمچنین می توانید با  

 برای شما فعال خواهد شد. Video Toolsپس از درج فیلم سربرگ  

 videoنحوه شروع به پخش 

اینکه تعیین کنید تمایل دارید   به    Videoجهت  به طور خودکار، در سربرگ  با کلیک کردن شروع  یا  پخش کند و 

Video Tools    به تبPlayback    رفته و در قسمتVideo Options   با باز کردن لیست آبشاری مقابل عبارت

Start.گزینه مورد نظر خود را انتخاب کنید ، 
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را بزنید، به حالت تمام صفحه نمایش داده می    Play Full Screenدر صورتی که تیک گزینه  ،  Playbackدر تب  

 شود. 

را بزنید، هنگامی که فیلم در حال اجرا نیست، آیکن آن   Hide While Not Playingدر صورتی که تیک گزینه  

 نمایش داده نمی شود.

باره شروع  فیلم دورا بزنید، هنگامی که پخش فیلم به پایان رسید،    Loop Until Stoppedدر صورتی که تیک گزینه  

 به پخش می کند. 

 کنید. تغییر، میزان صدای فیلم را Volumeبا کلیک بر آیکن  

 
، می توانید تعیین کنید که هنگام آغاز  Fade Outو    Fade Inبا اختصاص عدد به  ،  Fade Durationدر قسمت  

 صدای آن به تدریج زیاد شود، و هنگام پایان فیلم صدای آن به تدریج کم شود.
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با کلیک بر علمت سبز   فیلم را تا هر جا که خواستید برش بزنید.  ی، می توانید ابتدا و انتها Trim Videoدر قسمت  

 & Dragآن به سمت راست، ابتدای فیلم را برش بزنید. و با انتخاب علمت قرمز رنگ و    Drag & Dropرنگ و  

Drop   گزینه   آن به سمت چپ، انتهای فیلم را برش بزنید. سپس بر رویOk .کلیک کنید 
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 درج موزیک  2-21

  Insertاستفاده کنید و هم می توانید به تب    Drag & Dropجهت درج موزیک هم می توانید مانند مورد قبل از  

از فایل موزیک  انتخاب کنید که مایلید  کلیک کنید. در منوی باز شده،    Audio، روی آیکن  Mediaرفته و در قسمت  

استفاده کنید  موج در سیستم خود  را ضبط کنید    (…Audio on My PC)ود  هستید صدا  مایل  یا   Record)و 

Audio…).برای مثال گزینه اول را انتخاب کنید . 
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 Audioنحوه شروع به پخش 
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اینکه تعیین کنید تمایل دارید   با کلیک کردن شروع به پخش کند و یا به طور خودکار، در سربرگ    Audioجهت 

Audio Tools    به تبPlayback    رفته و در قسمتAudio Options   با باز کردن لیست آبشاری مقابل عبارت

Start.گزینه مورد نظر خود را انتخاب کنید ، 

 

 زنید، در طول اسلیدها پخش خواهد شد. را ب  Play Across Slides، در صورتی که تیک گزینه  Playbackدر تب  

 را بزنید، هنگام پخش، آیکن آن نمایش داده نمی شود.   Hide Furing Showدر صورتی که تیک گزینه  

به پایان رسید، دوباره شروع   Audioرا بزنید، هنگامی که پخش    Loop Until Stoppedدر صورتی که تیک گزینه  

 به پخش می کند. 

 ، میزان صدای فیلم را تغییر دهید.Volumeبا کلیک بر آیکن  
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، می توانید تعیین کنید که هنگام آغاز  Fade Outو    Fade In، با اختصاص عدد به  Fade Durationدر قسمت  

 صدای آن به تدریج کم شود. Audioصدای آن به تدریج زیاد شود، و هنگام پایان  

 
را تا هر جا که خواستید برش بزنید. با کلیک بر علمت   Audio، می توانید ابتدا و انتهای  Trim Audioدر قسمت  

ابتدای    Drag & Dropسبز رنگ و   انتخاب علمت قرمز رنگ و    Audioآن به سمت راست،  با  را برش بزنید. و 

Drag & Drop  آن به سمت چپ، انتهایAudio   را برش بزنید. سپس بر روی گزینهOk .کلیک کنید 
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